Movavi Video Suite 24

What do you need help with today?

Removing trial restrictions Editing video
Activate Movavi Video Suite and remove all restrictions Create a movie from videos and photos
Capturing video Recording screen
Record video from a camera Capture any fragment of your screen or the full desktop

Need more help?
Visit the Movavi Support Center



https://www.movavi.com/support/
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Activating Video Suite

There are three ways to activate Movavi Video Suite:
3



- by logging into your Movavi account,
- using the key through Video Suite,
- using the key through one of the programs included in Video Suite.

Activation via login
To log into your Movavi account, click the icon in the top-right corner of the launcher.

@ -
] ® 1
| ! <
Recreate Zack King's ’ High-Quality Stock ‘ Create Your Own
Tricks ~ Videos! k Cartoons!

8% Programs (® Video Audio Photo 0 pata

s Movavi Suite

Programs

Video Editor 24 a Video Converter 24 a Screen Recorder

Capture from Watch video Gecata
cameras, VHS, TV

L Activate Try Realluison 2  Video Editing
Cartoon Animator Service
Buy

Learn More

Choose how you want to log in or register:
+ with Google (enter the email address you used to purchase Video Suite)
« with a special Magic link (link to log in instantly and without a password)

Log in to your Movavi Account
New here? Create ¢
@ .
o.® Movavi Account

Log in to activate your programs and manage
your subscriptions

When you click on Get magic link we will send you an email with a link to log in instantly and without a password. Movavi Video Suite will be
activated as soon as you log in to your account.

Activation with your key through Video Suite
To activate the program with a key, click Activate in the bottom left corner of the program.

L Activate

Buy

Then enter the key in the field and click Activate.



Activating Movavi Suite

The trial period ends in 7 days. Click Buy to purchase the full version of
the software. If you already have an acbivation key, enter it below.

0

Activation with your key through one of the programs
Click the Programs tab and launch the needed program.
Enter your activation key and click Activate. Restart Movavi Video Suite. This will activate Video Suite and all its programs.

Activating without Internet access

Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

Buy Activation Ke)

>

Step 2: Launch any application in Movavi Video Suite (for example, Video Editor). Enter your activation key and click Activate through one of
the program. Then click Activate.

Activating Movavi Video Editor 24

L c]

How do I activate the program?

Buy Activate Close

Step 3: In the next window, click Copy and transfer this information to a computer or device with an Internet connection.



http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help

Step 1. Send an email

oy within an hour

Step 4: When you have access to the Internet, paste the information you copied into a new e-mail and send it to regq@movavi.com. You
should receive a reply within an hour. Copy the registration key from the reply and transfer it to the computer with Movavi Video Suite.

Movavi Video Suite Activation - X
reg@movavi.com
Movavi Video Suite Activation

Please copy this text and email it to us at reg@movavi.ru. To ensure a fast response,
do not change the body of the message.

Activation Key: 111111-22222-33333-44444-55555-66666-77777
Hardware 1D: 1052-4B7E-4765-5E27-7578-0000-0000-B1EB
Product ID: suite23

E-mail: regq@maovavi.ru

- 1 — -
2 —

mi@ica@@Q&?EI'@'e 0

Step 5: Return to the window with offline activation. If you've closed the window, repeat steps 1-3 and enter the same activation key you
used before. Then, paste the registration key into the box and click Activate.

© @ SansSerif + T+ B I U A~

Step 1. Send an email

t and email it to us
not change the body

2y '.'.-'I‘._'l'll"l an Nour.

44444 - 55555 - B6666 - 77777 (]

' Activate '



mailto:reg@movavi.com

Getting an activation key

To activate Movavi Video Suite, you will need an activation key. You can buy an activation key from our official website or from any of our
partners, and it will be delivered to you via e-mail.

1. On the Movavi Video Suite launcher, click Buy or use the button below.
Click the Help menu if you are already in the process or recording or editing.

Buy Activation Key

2. On the purchase page, click the Buy Now button next to the type of license that you need.
« If you're a home user, choose the Personal License.

« If you're planning to use Movavi Video Suite for work, business, or government organizations, choose the Business License.

3. Fill in your billing information and enter a valid e-mail address. IMPORTANT! We will send the activation key to this e-mail address, so
please make sure it is entered correctly.

4. After you've completed your payment and your request has been processed, you will receive a confirmation e-mail with your activation
key.

If you haven't received your activation key:
* Check the Spam folder of your mailbox
+ Contact support

Trial limitations

Movavi Video Suite does not have a trial version. However, the programs included in Movavi Video Suite have trial versions.
The trial version starts working as soon as the program is installed. The trial version allows you to try all the functions of the program,
however, the following restrictions apply in trial mode:

& Program will stop working after 7 days Vv Lifetime license

& A watermark with the words ' trial version' will be added to all “ No annoying watermarks
output videos

& System sound recording is disabled " System sound recording

& Taking screenshots is disabled “ Taking and editing screenshots

& You can only convert half of each audio file and half of each video " Unlimited video and audio conversion
if you use SuperSpeed mode

" Free updates
" Discounts on other Movavi products and upgrades

Launcher

The interface of Movavi Video Suite is divided into three main regions: the My programs board, the program'’s side menu, and the top
section.

The top section consists of the latest news, interesting articles, and helpful instructions.

1@ ' ®
\, < Upgrade to
Create Your Own - o Movawi

Undimited

Favorites

o Edit Video

New Project -

ﬂ Al Upscaling G S o Mobite Companton

Recent projects and files

e
-

-

The program'’s side menu consists of:

* My programs and My files tabs;
« Store section;

 Extras section;

- dark/light theme toggle button.


http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/support/contact.html

To enable light mode, click the toggle button. If you want to switch the program interface back to the dark mode, click the toggle button
again.

| & Add Files |

The Store section offers you more content to enhance your videos:

+ the Programs tab offers more programs for working with different kinds of media and documents.

« the Effects tab consists of additional effects sets - titles, stickers, backgrounds and transitions for your videos.

+ in the Stock content tab, you can get additional sets of special effects, as well as stock video clips, audio tracks, and images.

+ the Online courses tab features video clips and online video courses that you may use to get more professional and creative in terms of
video making.

7 (o] 9
- i ‘ -
» Upgrade to  m 3
Havavi - Free Pk for '
Ui ited How to Make 2 Meme Subsoription!

-

E AI Upscaling E Photo editing

*  Recent projects and files

The My programs tab consists of:

+ a board with the favorites and the main functions of the program;
« recommended programs, effects and online courses;
* recent projects and files.

The Favorites board allows you to add the functions you use the most to begin working right after the program starts. To add a new feature,
click the plus button and select the feature you'd like to set up quick access to. It will appear on the quick access board. To remove a feature,
click the three dots button and then click Remove from favorites.

Suite Mobile  *
Companion

- uve L 1w =S
% Edit Video = - - - = B -1 Record computer screen

Favorites

E) a1 upscating

Add feature

“ Recent projects and files

All the program features and tools are sorted according to the media type:

* Video - to edit, convert, trim, or watch a video and record your screen or capture TV or VHS signal.
+ Audio - to convert, record, play, and even burn your music to a CD or DVD.

8



* Photo - to convert pictures as well as make a slideshow with music and transitions.
+ Data - to import an AVCHD video, burn a disc, or copy one.

Recommaended effects

==/, B BLOGGER

UNDLE s ™
== X ]
AV ASAED EECERITIAL S =

Viogger Exsentials Bundle Blogger Sat TRAVEL SET

sasos D 4, | Learn Mo s205 0 L, (| Leamn More s24.95 9

s Winl e
Enstall Video s by
ke

Suite Mobile -
1 companion

Favorites

] Edit Video G Convert video ﬂ Record computer screen

Lursch 2

ﬂ AI Upscaling a Phate aditing kad Mabile Companian

*~ Recent projects and files

The My files tab leads to the library, which contains all the files and projects you work with. You can also add files to the library manually and
open them in any program.

My files

The My files tab leads to the library, which contains all the files and projects you work with. You can also add files to the library manually and
open them in any program.

Use the tags on the top panel to quickly search the files by the file type.



¢ Movavi Suite

28 Myp

L] | [ T en—
oo All programs

rograms

You can choose how the files in your library are sorted. To do that, click the arrow and select the option you want.

[ Images

= Time added

File name

Adding files to favorites
To add a file to your favorites, hover it with your mouse and click the heart icon.

Images

L : et i
F —
i

Projects

4

Adding files to library
To add files to your library, click Add Files. Then select the files you want to add and click Open.

Projects

4

&, Add Files

10



Removing files
To remove a file, hover it with your mouse and click the icon with three dots. Remove from Library removes files only from your Video Suite
library and keeps them on your computer. Remove from Computer completely deletes files from your hard drive.

You can also remove several files at once. Select the files you want to remove by checking the boxes on the bottom left corner of the
thumbnails and then click Remove.

Sharing files
To upload a file online, hover it with your mouse and click the sharing icon.

Projects

You can also share multiple files at the same time. To do that, select the files by checking the boxes on the bottom left corner of the
thumbnails and then click Share.

11



More about uploading files online

With the Mobile Companion app, you can transfer files from the Video Suite library to your phone. Select the files you need and click the Send
to Phone button. After the files are sent, open the app, sign up with your Google account and upload the files.

Projects

You can also transfer files the other way around — from your phone to the Video Suite library.

Uploading files online

1.Select the service you would like to upload your videos to: Youtube, Vimeo or Google Drive.

Upload to Youtube

Sign in to

2. Click Sign in. The authentication page will open in your browser.
Sign in to your account and click Allow to let Movavi Video Suite upload videos.

12



Upload to Google Drive

Sign In

Sign in to upload files

Uploading to Google Drive

1. Select a Google Drive folder where you want your file to be uploaded. You can create new folders in your Google Drive storage straight in
the export window.

2. Click Upload to export your file.

Upload to Google Drive

I New folder

Uploading to Vimeo

1. Set the level of privacy:

Anyone - any person can watch the video.

Only people | follow - only people you're subscribed to can watch the video.
Only me — nobody, but you can access the video.

2. Fill in the description for the video.

3. Add tags.

4. Click Upload to export your video.

Upload to Vimeo

Privacy:
Anyone
Description:

Created with Movavi Video Suite

Tags:

movavi, movavi video suite

Edit video with Video Editor

13



Using Movavi Video Suite, you can create your own movies using the media files you have on hand. To open Movavi Video Editor, go to the
Video tab, then click Video Editor.

o K 5 =

/
Use Our Video Editing ’ Upgrade to Movavi How to Add Create Your Own
Services Unlimited Horror Effects Cartoons!

Video Converter £4 ﬂ Screen Recorder

**  Video Editor

L Watch video Gecata
cameras, VHS, TV

Buy

Cz:, Try Realluison . Video Editing
Cartoon Animator Service

How to use the Editor?

Step 1: Add media Step 2: Edit video
Add videos, photos, and music to your video project. Edit and enhance the video clips to
Open captured videos in the Editor make your video just the way you like it.
Record video Cut and split video
Record audio Rotate clips
Arrange files chronologically Crop the frame
Apply cool filters
Step 3: Join clips with transitions Step 4: Annotate your video
Drag-and-drop transitions from the Video Editor's Get your thoughts across with sound and text.
extensive collection to join clips with fun animations. Record a voice-over
Add text titles

Step 5: Save your video
Export your project to a common video format.
Save for devices
Save for uploading online

Activating and installing packages

Expansion packages are sets of additional content, which include transitions, titles, stickers, backgrounds, and music. The packages help
you achieve your creative goals, broaden your freedom of expression, and save time choosing the right artistic tools.

Acquiring a package
1. Go to Movavi Effects Store. You can also find this this link in the Help menu > Movavi Effects Store. Or by clicking a cart icon in effect,

transition, title or sticker collections.
2. On Movavi Effects Store web-page choose and purchase the packages you like. After the purchase is processed you will receive an e-mail

with an activation key, a link to download the package, and an instruction on how to install it.

14


https://effects-store.movavi.com/

Installing a package

1. Click the link you received with the e-mail and download the package.

2. When the download is finished, open the package as you normally would open your project: double-click the file or drag and drop it in the
Video Editor. The program will run the installation process.

3. In the Installing Package window click Install and follow the instructions on the screen.

INSTALLING PACKAGE

Warm Memaories Pack

we content!

Install ( cancel

Activating a package

1. Copy the activation key from your email.

2. Paste it in the in the Activating Package window.
3. Click Activate.

ACTIVATING PACKAGE

Warm Memories Pack

ease enter your activation ke

33-44444-55555-66666-777

Wait until the installation is finished. The new elements will appear in the corresponding categories. The categories with the new elements
will have a yellow dot on them and the elements will be marked with the NEW label.

Cannot install or activate the package? Make sure that:

* The Video Editor you have installed on your system supports the packages;

* You use the key that was sent to you after the purchase of a package and there are no additional symbols after the key;
* You have enough free disk space to install the package.

Quick Video mode

You can use the Montage Wizard to automatically build a video for you in minutes. All you need to do is provide the Wizard with some video
clips or photos, choose a music track, and let the Wizard cut and build the video for you. You can also use the Montage Wizard to make
slideshows.

1. Click Quick Video to open the Wizard.

File import

Media bin

2. On the Files tab, click or drag and drop your files over the window. To remove files, click the E&l in the upper right-
hand corner of each file, or select the files you want to delete and click Delete Selected on the bottom panel.
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7.
8.

9.

. Switch to the Templates tab or click Next.
. Choose a theme or a transition template.

No transitions template does not add any transitions to your video, but your pictures will still have a Pan and Zoom effect applied by
default.

Transitions template puts some kind of smooth transitions between the slides.

Theme template uses the sample music tracks, a set of different transitions for each of the themes and various title styles.
. Switch to the Music tab or click Next.

. Add music. Choose from the built-in tracks* or add music of your own. You can also add more than one track.
*The audio tracks are royalty-free so you can upload these videos to YouTube and other services.

Switch to the Preview tab or click Next.
Customize the opening and ending titles, change text and click Apply.

¥ Opening titles

v End titles

Under the Advanced tab make other necessary changes.
* Video duration

You can set your video to be the same length as the audio by selecting the Fit to music length option or use the slider to set how long you
want the video to be. If you opt for a shorter video, some clips may not appear in the end result.
* Fill black bars

If the resolution of the project and the files you've added to the video are different, black bars will appear. You can remove them by
checking the Fit to frame option — the image resolution will be automatically fitted to the frame size.
Learn more about frame size

* Volume balance
16



By bringing the upper slider to the right end you will turn the volume of the added video up to maximum. And by bringing the bottom slider
to the right end, the volume of the background audio track will have its maximum volume.

* Arranging clips

If you have a lot of pictures and want to change their order in the video, click the Shuffle button. The Wizard automatically mixes your files
and puts them in a different order.

Video duration

Fill black bars

Volume balance
n o

Arranging clips

Tip: You can also set a desired order of appearance of your files by returning to the Files tab and dragging the file icons in a desired order.

10. Watch the finished video in the player on the Preview tab and switch to the Export tab.
11. Select what you want to do next with your video:
« Save the video — save the video to your disk.
« Continue editing — add final touches to your video by adding effects, more titles, animation and more.
+ Upload online — save the video to your disk and upload it to YouTube, Vimeo, Google Drive or Movavi Cloud.

12. To save the video, choose a video format and pick a folder to save the video file.

If you're uploading the video to YouTube, sign in with your YouTube account and fill in the details about your video. Then click Start to
begin saving the video.

Save Video to the Computer

Learn more:

Adding filters

Adding titles
Color adjustments

Removing black bars

New Project mode — quick start

In this mode you can use all the tools that the Video Editor has to offer and create professional-looking videos without complicated software.

You can create a new video by creating a new project or a quick video.

1. To start creating a project just add files on the Timeline. If you want to start another project select Create New Project in the File menu.

17
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3. Change the clip layout on the Timeline, crop images, cut videos, using the toolbar.

4. Add effects, transitions, titles, and more by changing the tabs on the left-hand side of the screen.

5. To add filters and transitions to the project, drag them to the Timeline.

18



6. Save your video:
1) Click the Export button.
2) Choose file format.
3) Name the video, select a folder to save the video to and set the quality.
4) Click Start and wait until the processing is finished.

Save Video to the Computer

°d Make sure to save your work once in a while: choose Save from the File menu to save the project so that you can access it later.

Creating and managing projects

How to create, save, and open projects and finished videos
A project keeps all the work on your video or slideshow. You can save the project to finish your work later, or restore your work if you need to
edit something after you've finished. A new project is created automatically when you start working on a video.

Creating a new project
1. On launching the Video Editor you can start making a video right away.
2. To start a new project while working on another project, go to the File menu and select Create New Project or Create Quick Video.

Saving projects

1. Go to the File menu and select Save Project. Or use a keyboard shortcut Ctrl+S.

2. Name your project. All projects are stored in the "\My Videos\Movavi Video Suite\Projects” folder of your user.
3. Click Save.

You can later open the project file and continue working on it. To avoid losing your editing progress, make sure to save your project every once
in a while. To save a project, open the File menu and select Save Project.
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After that, you can save your project as a file in the *.mepx format on your computer and open it later to continue editing your movie.

Viewing videos

Project files cannot be viewed in a regular video player, and can only be opened with Movavi Video Editor. To view the final video in a player,
you need to first export your project to a common video format.

Learn how to export your project

Opening projects
1. Open the File menu and select Open Project.
2. Find the project file, select it and click Open.

You can also open projects in several different ways:
A. Find your project in Explorer and drag it onto the Video Editor window or double-click it.
B. In the Import area click Add Files and select find your project.

Media use

When you add files to a project, Movavi Video Editor uses the original file for reference as you edit the movie. To save your disk space, Movavi
Video Editor does not make copies of the files, but rather remembers the location and name of the original file, so if you move or delete the
files, they will also disappear from the project.

Because all of your editing work is done in the project, your original files are not edited in any way, and you do not need to make reserve copies.

How can | play my project?

Project files cannot be viewed in a regular video player, but can only be opened with Movavi Video Editor, Movavi Screen Capture Studio, or
Movavi Video Suite. To view the finished work in a player, you need to first export your movie to a common video format.

Learn how to export your project

Appending a project
If you work on a big project, you might want to separate it into several smaller ones for a more convenient editing process. Then, to combine
them back together, append other projects to the major one.

1. Open a project or create a new one.

2. Open the File menu and click Append Project.

3. In a new window, find and open the project you want to combine with your current project. The project you append will be added at the end
of all other clips in the current project.

Settings Export Help

Recent Projects >

Append Project...

Ctri+5

Ctri+Shift+5

Adding media files

To begin working on your video project, you first need to add some media files. Use your own files or any of the built-in media.
20



File import

Media bin

Sounds

Add Files

Backgrounds

Add your files

1. On the File import tab click Add Files.

2. Select the files and click Open. They will appear on the Media bin tab.

3. From the Media Bin tab drag and drop the files onto the Timeline. You can remove the selection of all files by clicking on an empty space
within the bin area, or by selecting a single file.

Add built-in media

1. On the Import tab select the type of media you want: sounds, music, sample video or backgrounds.
2. Switch to a tab.

3. Click the file icon to download and see it or to listen to it.

4. Choose a media file and drag it onto the Timeline to add to the project.

Arrange the files

Once you've added the files, they will appear on the Timeline at the bottom of the window. The Timeline allows you to arrange the clips in the
order you want. To reorder the clips, select the clips you want to move and drag them to the new position.
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See also:
Working with video
Working with audio

Creating an intro

Intro videos are specifically designed short video clips that use visual elements and text and can be edited or customized. If you don't know
where to start in making a unique intro, you can use the ones that are already made and pre-installed into the program. You will only need to
change the text.

Create a new intro

1. In the Titles collection go to Intro videos.
2. Find the New intro clip and drag and drop it onto the Timeline.
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Edit the intro

1. Click @ on the clip and the Timeline will switch to the intro editing mode.

2. Add your own media files (video, audio or pictures), effects, titles and other. Work as if you're working with a usual project, but keep in
mind that your making a special introductory video.

*Before you start editing, delete the instruction clip that the new intro contains.

Save changes

Click R EEEREEINY on the toolbar to save changes and go back to the main editing mode.

To save the intro and use it in other projects, select the intro clip and click ®. The intro will be saved with all the other items in the collection.
You can edit the intro at any time while working on the project.

Recoding video

1. Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is working

correctly.
2. On the Import tab of the <HE 3ABbbITb>: 3agaiTe 3HaueHne nepemeHHOM, click Record Video. The recording module will openin a

separate window.

File import

Media bin

3. In the Video capture device box, choose the camera.

4. Then, select the resolution and frame rate. A larger resolution will be able to retain better quality, however, the video file size will be larger.
A higher frame rate is necessary for recording motion, while static scenes can be captured with a lower frame rate.

5. In the Audio capture device box, choose the microphone.
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Logitech HD Webcam C270

Resolution: Frame rate:

Default v 30

Audio capture device:

MukpodoH (HD Webcam C270)

6. Choose a destination folder. By default, the recordings will be saved to your Movavi Library folder. To change it, click the icon o near the
Save files to box.

7. Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera icon on the right.
8. When you're done, click Back to editing at the bottom of the window. The captured files will be added to the Timeline and saved to disk.

Capture settings

* Saving captured files

Preview and organize clips

Use the player in the upper right-hand part of the window to preview your project.

Current position
Your current playback position can be controlled using the position marker under the player and on the Timeline.
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For precise positioning:

* To move in 0.5 second increments, open the Playback menu and choose Skip Forward by 0.5 Seconds (Shift+Ctrl+Right) or Skip Backward
by 0.5 Seconds (Shift+Ctrl+Left).

*+ To move precisely from frame to frame, use the Previous frame (Ctrl+Left) and Next frame (Ctrl+Right) buttons in the player.

* To switch between clips, use the Previous clip (Shift+Left) and Next frame (Shift+Right) buttons in the player. This will move the position
marker exactly one frame backward or forward.

* Use the Scale slider to zoom in on the Timeline to make positioning easier.

Playing the video

1. Move the position marker to where you want to start playback.

2. Click Play or press the Space Bar key.

3. Click the Pause button or press the Space Bar again to pause playback.

= - '-__“'1: 'l: v
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1 — player position marker 7 — next clip

2 - current time 8 - aspect ratio of the project

3 — previous clip 9 - player volume

4 - previous frame 10 - snapshot of the player

5 — play/pause 11 — additional settings of the player
6 — next frame

Arranging clips
By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips, drag them with your
mouse and drop them onto the desired position. To select multiple clips, use Ctrl+click or click and drag to draw a selection on the Timeline.
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Gaps on the Timeline

Gaps on the Timeline are empty spaces between clips on the video track.

Adding of the gaps

1. To enable gaps, click the arrow icon in front of the video track.

Hide Track

Mute Track

Add Extra Track

2. To add a gap, press the clip with the left mouse button and drag it to a distance from the other clip.

Deleting the gaps
1. Right-click the gap you want to delete.

2. Select Delete Gap to remove the selected gap. Select Delete All Gaps to delete all the gaps on the track. When you delete gaps, the clips
will move towards each other.

Ripple delete

To delete a clip on the track and move all the clips on the right side by the length of its duration, without deleting gaps, select Ripple Delete.
Right-click the clip you want to delete.
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Play / Pause

Hide Clip

Tools

Detect Scenes

Detach Audio

Ctri+C
Chrl+x
Ctri+W
Del

Ripple Delete

show in Folder

File Information

Disabling gaps on a track
To disable gaps and move all clips to each other, click the crossed-out arrow icon in front of the video track.

Hide Track
Mute Track

Disable Gaps on Track

Add Extra Track

Edit and enhance clips

Arrange, edit and enhance clips with the tools that you can find on the toolbar and on the More tab.

In a table below see what tools you can use on clips and how to apply them.
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Split Set the position marker on the Timeline where you want to separate your clip and cut it.

Rotate Turn the clip clockwise.
Crop Set on the player the space you want to keep and cut the borders.
Adjust color Make the necessary color changes using presets or set them manually.

Turn the sound up or down Click Clip properties and use the Volume slide to change audio loudness.

Normalize the video sound Select the Normalize checkbox in the Clip properties to make the sound smoother.

Change video speed Click Clip properties and use the Speed slide to make the video faster.

Reverse the video Select the Reverse checkbox in the Clip properties to play the clip from the end to the
start.

Change opacity Move the Opacity slide to make the clip transparent.

Change clip length To change the clip length move the borders of the clip on the Timeline or use the Speed
slide to make the clip faster.

Make clip fade in or out Use the Fade in and Fade out slides to make the clip appear and disappear smoothly.

Clip Properties

General  Applied Effects

¥ Volume:

Edit videos and images
Photos and videos aren't always perfect from the beginning. Use the buttons on the toolbar to fix and adjust the clips.

Picture in picture and overlays

To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of the Timeline to
create an extra overlay track. Then, double-click the upper clip to set up where the overlay will be shown on the video.

Learn more about overlays
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Picture and picture, side by side overlay modes.

Rotating videos and images

Nobody likes vertical videos! But don't worry, in just a few clicks, you can turn any photo or video around without having to crane your neck.

Rotating by 90 degrees
1. Select the clip you want to rotate
2. Click the Rotate button on the toolbar to rotate the clip by 90 degrees clockwise. Click the button again to rotate the video more.

Learn more: Removing black bars

Fixing the horizon level

1. Select the clip on the Timeline.

2. Click the Crop button on the toolbar.

3. Use the Angle slider to slightly rotate the clip inside the frame, until the horizon is level with the guides in the player.

Crop and Rokate

Angle:

Apply

Cutting clips

Use the scissors button on the toolbar to cut video and audio clips into parts. To delete a clip you don't need, click the trash can button.
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Splitting clips into parts

1. Select the clip that you want to split.

2. Move the position marker to the moment where you want to cut the clip.
3. Click the Split button on the toolbar.

Utro_na_more_oum_ru.mp3
it

How does the cut clip look like.
Cutting out fragments
Cut the clip at the beginning of the unwanted fragment
1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the Previous Frame and Next Frame buttons on the player to catch
the moment precisely.
3. Click the Split button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.

Cut the clip at the end of the fragment
1. Select the second clip the you've just cut off.
2. Move the position marker to the end of the fragment.
3. Click the Split button again. The fragment should now be in a separate clip.

Delete the unwanted fragment
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the Delete key to remove this clip. The clip will be removed, and the remaining clips on the
Timeline will move to close the gap.

Trimming clips
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If you only need to cut off some parts at the beginning or at the end of a video or audio clip:
1. Place your mouse pointer over the edge of the clip.
2. Click and drag the edge towards the center of the clip to trim the clip to the desired length.

Utro_na_more_oum_ru.mp
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For more precise navigation:

* Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second
forward or back.

* Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Shift+Ctrl+Left and
Shift+Ctrl+Right.

» Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+Left and Ctrl+Right

keyboard shortcuts.

+ Use the Previous Clip and Next Clip to switch between the clips in the player. You can also use the Shift+Left and Shift+Right keyboard

shortcuts.

Cropping video

Cropping a video can help you remove black bars, cut away the edges of the video, or permanently zoom in onto an object inside the frame.

1. Select the clip on the Timeline.
2. Click the Crop button on the toolbar to open the Crop tool, and a cropping frame will appear inside the player.

Crop and Rotabe

3. In the player, set the frame so that the parts you want to cut are outside it. Drag by the corners of the frame to change its size, and drag by
the center of the frame to move it.
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Crop and Rotate

4. Click Apply. A star £ icon will appear on the clip once you've applied cropping.

Removing crop
1. Click the star icon on the clip to show the list of applied effects and filters:

Clip Properties

General Applied Effects

Filter: Qil painting - fine

Color adjustments

Change color settings
1. On the Timeline, select the clip that you want to adjust.
2. On the toolbar, click the color adjustments button to open the adjustments tool.
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Color Adjustmiants

Codor Adpstments
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3. Select Easy mode to use color presets for quick and simple adjustment. Also you can change the color of the video using color templates.
To apply the template drag it to the clip.

olor Adjustments

Advanced

°d If made your own adjustments to the image and want to save them for future use, click Save Adjustments and name your preset. The
new preset will appear on the Auto Adjustments tab.
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Color Adjustments Save Adjustments

Easy Advanced

White balance
Brightness
Contrast
Saturation
Highlights
Gamma

Shadows

Video speed

Speed up or slow down a video or audio clip with the Speed slide. This can be useful if you're working on a music video and you want the
video to match the tempo of the music.

1. On the Timeline, select the clip you want to edit.

4 You can also change the speed of any audio clip. If you modify the speed of a video with built-in audio, the audio speed will also be
changed.
2. Click the Clip Properties button to open the editing tools for the selected clip.

Clip Properties

General Applied Effects

3. Drag the Speed slider to set the necessary video speed.
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Clip Properties

General Applied Effects

4 The clip's length on the Timeline will change to reflect the new speed. If you've changed video speed, the video clips will be marked with
a staricon:

Reversing video

Reversing the video will play the clip and its audio backwards. You can combine reversing the video with increasing speed and the VHS filter
to create a cool rewinding effect.

1. On the Timeline, select the clip that you want to reverse. You can reverse both video and audio clips.
2. On the toolbar, click the Clip Properties button to open the properties for the selected clip.

Clip Properties

General Applied Effects

¥ \olume:
Normalize:
Speed:
Fade in:

Fade out:

3. In clip properties, select the Reverse option.

Clip Properties
General Applied Effects

v Volume:

Speed:

When you apply reverse, the clip will appear with a reverse icon on top of it:
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Image duration

You can change how long each image appears in your video or slideshow either using the clip properties or you can set all images to the
same length.

Changing one image's length
1. On the Timeline, select the image clip that you want to edit.
2. Click the Clip Properties button to open the properties for the selected clip.

General Applied Effects
Fade in: o 0,00 sec.
Fade out: o 0,00 sec.

Duration: 00:00:04.000

CRE I L 2

3. In the Duration box, enter the new length of the image. Use the following format: hours: minutes:seconds.milliseconds. Changes will be
applied instantly.

General Applied Effects
Fade in:
Fade out:

Duration: 00:00:04.000

4 You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The longer the clip
appears on the Timeline, the longer it will play in your movie or slideshow.

Setting the same length for all images
To set all of the project's images to the same length:

1. Click the Transition Wizard button on the toolbar.

2. In the Transition Wizard window, enter the preferred length into the Image slide duration box. If you don't want to use transitions to join
your clips, select No transitions in the box at the top.

3. Click OK to set all the images to the selected length.
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2 This transiton style T

Clip Proparties e
Use random transitions

Transition duration:

Image slide duration: 04

Enable Pan and Zoom effect

Fading video
In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use fading
simultaneously with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.

1. On the Timeline, select the clip that you want to fade.
2. Click the Clip Properties button on the toolbar. The clip properties will open in the Tools panel above.

Clip Properties

General Applied Effects

3. Set the fade length using the sliders on the Video tab.

7 Fade in — how long in seconds it will take to fade in to full opacity at the beginning of the clip.
Fade out — how long in seconds it will take to fade out from full opacity at the end of the clip.

General Applied Effects

Fade in:

Fade out:

Duration: 00:00:04.000

See also:
Adding transitions

Fading audio

Creating overlays

Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture in picture effect,
add a logo or watermark, create a Chroma Key effect, or insert a short clip without cutting the main video.

1. Add files to the project: a background video and a foreground video or a photo.
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2. Select a clip which should go on the overlay track and drag it above the main video track.

IMG_4830 i

3. Place the clip on the overlay track at the right time on the needed position. You will see a line connecting the clip on the overlay track to the
clip on the video track. When you move, cut, or delete a clip on the video track, the overlay clip will be affected as well. When you move the
clip on the overlay track, an editing panel will open. If you switch to a different tool, you can go back to this panel by clicking More Tools —
Video Editing — Overlay.

Owvarlay

Picture in picture mode

This is the default overlay mode. Using picture in picture mode, you can place the overlay video over any part of the screen.
1. Choose Picture in picture mode.

2. In the player, move the overlay clip to where you want it to appear in the frame.

3. To resize the overlay, drag at its corners. Clip's aspect ration will remain the same.
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Logo mode

1. Select Logo mode to place the overlay clip at the upper right corner and use it as a logotype.
2. Drag and move the logo to any part of the frame.

4 41 P > pl

Side by side mode

This mode splits the frame into two parts.

1. Select a clip on the overlay track and then choose a side by side mode.

2. Hover the cursor over the selected clip in the player. Move the image in the frame, and zoom in or out on it with the scroll wheel.

TN X3 16:9v P @ :

Trio mode

With this mode you can have up to 3 videos in a single frame.

1. Select a clip on the overlay track and then choose a side by side mode.

2. Hover the cursor over the selected clip in the player. Move the image in the frame, and zoom in or out on it with the scroll wheel.
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3. To add another video and get three in a single frame, add one more clip to the overlay track and repeat steps 1 and 2 for it.

LI

Overlap mode
In Overlap mode, the video on the overlay track will cover the main video completely. You can use this mode to avoid cutting the main video,
and showing another clip instead, or to create a Chroma key effect.

Learn more:
How to change background (Chroma key)

Adding a watermark

Adding a watermark to your videos will protect your ownership even if it's shared all over the Internet. You can add an image overlay with
your own watermark or logo, or make a new one using text.

Image watermark

1. On the Import tab, click Add Files and add the image or video that you want to use as the watermark. For the best look, use images with
transparent areas.

2. Drag the watermark clip up to the overlay track to make it appear on top of other videos.
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3. Double-click the watermark clip to edit the overlay, which you can move and resize in the player.

4. To change the opacity or duration of the watermark, click the Clip Properties button.

5. To set the opacity use Opacity slide in the properties. To make the watermark show over the whole length of the video, enter your project
length into the Duration box, or drag the right edge of the overlay clip until the end of the video track.

Clip Properties

General Applied Effects

Text watermark
1. Click the Titles button on the left and pick a nice title style for your watermark.
2. Drag the titles you like onto the beginning of the Titles track at the top of the Timeline.

e

Effecta
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3. Double-click the titles and enter your watermark text. Pick a cool font and color on the panel above the player. Click Apply when you're
done.

4. To make the watermark show over the whole length of the video, drag the right edge of the text clip until the end of the video track.

°d If your movie is long, zoom out on the Timeline to make changing clip length easier.

OR: Double-click the text clip to enter text editing mode and enter the length into the Duration field. You can find the length of your whole
project at the bottom of the window.
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Creating a freeze frame

A freeze frame is a single frame of a video that repeats for some time, creating an illusion of pausing the video. You can use freeze frames to

emphasize a moment or create a pause to explain things to the viewer.

1. Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous

frame and Next frame buttons under the player.

00:00:1

2. Once you're on the right frame, open the Edit menu or right-click on the clip and choose Insert Freeze Frame from the menu.

Play / Pause
Hide Clip
Tools

Split

Add Marker

Insert Freeze Frame
Detect Scenes

Detach Audio

Copy

Cut

Delete

Show in Folder

File Information

i =,
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Ctrl+B
Ctrl+M

Ctrl+E

Ctrl+C

Ctrl+X

it

3. By default, a new freeze frame is four seconds long. To change the duration, drag the edges of the clip to make the clip shorter or longer.

Learn about changing image duration
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Removing black bars

Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black bars around
them. You can remove black bars from videos using one of the ways below.

Use filter

1. On the Timeline, select the clip with black bars around it.

2. Click the Filters button on the left sidebar to open the Filters tab.

3. Find the Vertical fill filter in the Adjustments group and drag it onto the clip.
Learn more about filters

LI I O

Manual crop
If black bars appear only on one or several clips, you can cut off the edges to make the video fit better inside the frame.

1. On the Timeline, select the clip with black bars around it.

2. On the toolbar, click the Crop button.
3. A frame will appear in the player. Set this frame on the part of the video that you want to keep. Parts that are outside the frame will be cut

off.
4. In the Tools tab on the left, click Apply to accept the changes.
Learn more about crop

Crop and Rotabe

Fading effects

Make effects and filters fade in using the overlay track.

1. Copy the clip and paste it onto the Timeline.
2. Drag the copy of the clip on the track right above the original. Now you have two identical clips right on top of each other.
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4. Apply the effects or filters you want to use onto the upper, visible clip.
Learn more: Applying filters

Filters

Wy
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5. With the overlay clip selected, click the Clip Properties button and select General settings. There, use the Fade in and Fade out sliders to
set the fading time. Here you can also set Opacity if you want to reduce the effect's strength for the whole clip.

@ Clip Properties
Opacity:
Fade in:

Fade out:

The clip with the effect will gradually appear and disappear, exposing the underlying original clip.
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Adding and editing audio
Add an audio
1. To add music or other sounds to your project, open the Import tab.
2. Select File import category.
3. Click Add Files or just drag your files on the panel.

Also you can use one of the built-in music or sound tracks:
1. Click the Music or Sound category and take your pick from our royalty-free music collection.
2. Drag the tracks you liked on the Timeline.

d Al e
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Edit an audio
To edit the audio file, double-click the audio track, the settings panel will appear.

Clip Properties
General Applied Effects

¥  Volume:

Mormalize:

0,00 sec

Fade out: 0,00 se

Reverse:

Volume Sets the volume of the clip.

Normalize Makes quiet parts louder.

Speed Makes the audio play faster or slower.

Fade in The audio goes from complete silence to full volume in the time you set.
Fade out The audio goes from full volume to complete silence in the time you set.
Reverse Plays the audio backwards.

Recording audio

How to record an audio

1. Connect a microphone to your computer.

2. On the Timeling, place the position marker to where you want the recording to start.
3. Click the microphone button on the Import panel to open recording options.
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4. Set up your recording device and volume.
5. Click Start Recording and record the audio.
6. When you're finished, click Stop Recording. You'll find the recording on the Timeline.

(®© Record audio

Audio device: MukpodoH (Realtek High Definition Audio)
Volume: O 100%

Enable voice-over mode

Start Recording

Set start time for audio clips
After you've added the audio files, they will appear on the audio track of the Timeline as green clips. To change when the audio clip starts
playing, drag it along the Timeline, using the ruler at the top for time reference.

I Rec-6-2919.10.11-10.58.36.wav

Awakeaning.mp3

Extracting audio from videos

If you want to use a sound track from a movie, you can extract it from a video file and use it in your project.

On the Import tab, click Add Files and choose the video or just drag a video on the panel. The file will be added to the video track on the
Timeline.

File import

bin

Backgrounds
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- How to trim the parts of the video if you don't need to extract the whole audio track:

1. Move the position marker to the beginning of the fragment you want to keep and click the Scissors button on the toolbar. This way you will
cut off the beginning of the video.

2. Now, move the position marker to the end of the fragment you need. Click the Scissors button again, and the fragment will now be in a
separate clip. 3. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete them.

3. The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the audio stripe down
onto the audio track. If you don't need the video clip anymore, just delete it.

You can now work with the extracted audio clip separately.

rd

~ If you want to save the audio clip for later use, you can export it as an audio file:

1. Click the Export button at the top of the program.

2. In the Export window, switch to the Save Audio File tab.

3. Select an audio format.

4. In the Save to field you will see where on the disk the file will be saved by default. To change that folder, click Browse and select a new

folder.

Save Video to the Computer

5. Finally, click Startto save the audio file.

Looping audio

If the music file is shorter than your video, you can loop the audio and have the file play over again until the end of the video.

1. To copy the audio clip, right-click the audio clip on the Timeline, and choose Copy from the pop-up menu.
2. Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker. Repeat until the

audio length is greater or equal to the video length.
3. Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of the clip, and

drag it to the left.

Volume curves

Volume curves allow to control the volume for each part of the clip and smoothly increase or decrease the volume.
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Each clip has its own volume curve that starts out at 100% volume for the entire clip, and two points at its beginning and at the end. The white
line on the image below is the volume curve before you add any points.

P — e

Set the volume level
1. Drag the white line up or down to the necessary level. The top of the clip is 100% volume and the middle of the clip is 50%.

B b))

2. Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and choose Add Volume
Point from the pop-up menu.

3. Drag the audio point to the necessary volume level. You'll notice that the surrounding parts also move with the point to make the transition
smoother.

4. Make as many points as you need for each part of the clip where you'd like a peak or a drop in volume.

e e

5. To set the volume level for a part of the clip, you'll need at least two points. Create a point at the beginning and at the end of the fragment:

b

6. Create as many volume points as you wish to make a necessary effect.

Linking audio

To make audio clips to stay in sync with videos or images as you edit your project, link it to each other.

To link an audio

1. Select an audio clip on the audio track at the bottom of the Timeline.

2. Drag the track under the video clip you want it to link to.

3. On the left side of the Timeline click the Link button to create the connection between audio and video clips.

Fading audio

In the editing tools, you can add smooth fades to the beginning or the end of a clip and create a crossfade effect between audio tracks.

Fade in — how long in seconds it will take to go from silence to full volume at the beginning of the clip.
Fade out — how long in seconds it will take to go from full volume to silence at the end of the clip.

Set up the fading effect

1. Select the clip on the Timeline.

2. Click the Audio Properties button on the toolbar.

3. Set the fade length using the sliders on the Clip Properties panel.
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Clip Proparties

Fade in:

Fade out:

?['W!fwi

Equalizer

Using the equalizer, you can boost or reduce the levels of specific frequencies.

Set the equalizer
1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click More on the left sidebar and find Audio Editing to open Equalizer.

Audio Editing

Al e R

YW W A rwTwe

3. Choose an equalizer preset to set the effect quickly. If you want to set more advanced configuration drag the volume bars to adjust the
frequencies to the necessary level.

Equalizer

Preset:

4 kHz 8 kHz 16 kH=

4. To save your own equalizer presets for their further use, click the Save button. In the new window enter a preset name and click OK. The
created preset will appear in the presets list.

Noise removal

1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click More on the left sidebar and find Audio Editing to open Noise Removal.
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Audio Editing

LEE I I

3. Use the Noise suppression slider to set the amount of noise you want to remove.

7] Don't set the noise suppression too high if there isn't much noise because it can start muting other sounds.

Noise Removal

Move the slider to the right to remove more noise. High levels may

Moise suppression.

L

Audio effects

Audio effects can transform the sound of an audio clip.

1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click More on the left sidebar and find Audio Editing to open Audio Effects.

Audio Editing

LEE I I

3. Click the box in the Audio Effects section and choose an audio effect you like.
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Audio Effects

MNone

Mone

Echo

Muffled

Telephone

High pitch ‘
Low pitch

Very high pitch
Very low pitch

Radio

Removing effects
When you've applied an audio effect to a clip, a star icon will appear on it:

Clip Properties

General Applied Effects

Muftled

Beat detection

To make your video more dynamic, use the Beat Detection audio tool to automatically mark audio beats on the Timeline and then adjust your
video to the beat of the music.

1. On the Timeline, select the music that you want to detect beats for.
2. Click More on the left sidebar and find Audio Editing to open Beat Detection.

Audio Editing

&9
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3. In the Beat Detection tool, click Detect Audio Beats. The program will analyze the music and place beat markers on the Timeline.
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Beat Detection

Detect Audio Beats

rd

. After the beat markers have been placed, you can modify their tempo. Use the Min time between beat markers slider to make the beat
slower or faster.

Beat Detection

Min, time
beat mark

4. Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the beat.
Removing beat markers

1. To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select Remove Beats from the pop-up menu.
2. To remove all beat markers from your project, right-click the Timeline ruler and select Remove All Beats from the pop-up menu.

Synchronization

Sync audio in two clips automatically.

1. Click More on the left sidebar and find Audio Editing to open Synchronization.

Synchronization

= Synchronization

2. Select two clips with the audio tracks. Clips must be on different tracks!
3. Click Synchronization.

Synchronkzation

4 When syncing, the clips move to the right relative to the later clip on the Timeline.
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Filters
Add filters
1. Click the Filters button.
2. Choose All to see every filter in the collection or choose the specific category you need. To see the filter's preview in the player, click on it.
To find a specific filter, enter its name into the search box above the filters. Click the heart icon to add the filter you liked to the Favorites
group.

3. To add afilter, drag it onto the clip you want to apply the filter to.

rd

- You can apply a filter to several clips at once. Hold the Ctrl key, select the clips on the Timeline and drag a filter onto any of the selected
clips. The filter will be applied to all the clips you've selected.

Once you've applied a filter, a star icon will appear on the clip, indicating applied filters and tools.

Clip with an applied filter
Remove filters
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1. To see the list of applied filters and tools, click on the star Ed icon on the clip.
2. In the list, find the filter that you want to remove.

3. Click the cross button Bl to discard the effect.

Clip Properties

General Appled Effects

Transitions

Transitions are short animations that use geometric shapes and transparency to connect two clips.

Add a transition
1. Click the Transitions button on the left sidebar to open the list of all transitions. Click on a transition to preview it in the player.

2. Pick a style you like and drop it between two clips on the Timeline. Click the heart icon (O] to add it to your favorites list if you like it.

Ll
EFFECTS
STORE

Change transition length

1. Double-click a transition on the Timeline to open transition properties.

2. Enter the new transition length in the Duration field. By default, each transition will be set at 2 seconds long. The format is
seconds:milliseconds. If you want all transitions that are currently in the project to have the same length, select the Apply to all transitions
option.

3. Click OK to apply the changes.
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Transition duration:

y all transitions

Fill transition with: Trimmed content

—

Restore Defaults ':__ Cancel :}

There are more options to fill the transitions with, such as:

Trimmed content If you've trimmed the video, the trimmed bits will appear during the transition. If the
videos haven't been trimmed, a freeze frame is shown.

Freeze frame A static frame is shown during the transition.
Slow motion The part of the video overlapped by the transition is stretched to fill the entire duration.

Use this transition style for

Use random transitions

Transition duration:

Remove a transition
1. Right-click the transition on the Timeline and select Remove Transition from the pop-up menu.
2. If you want to delete all the transitions in your project, choose Remove All Transitions.

Transition Properties

Play / Pause

Remowve Transition Del

Remowe All Transitions

Titles

Add text to your video
1. Click the Titles button on the left side of the window to view the titles collection.

2. Click on a title style to preview it in the player and choose the titles you want to use. To add titles to your favorites, click the heart icon ..
3. Pick a title style and drag it onto the title track of the Timeline. Put it right above the video track, onto the time where you want it to appear.
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4. You can link titles to the clips by clicking the link icon “~ on the left side of the title track, so that the titles will move with the clip.

Edit titles

To change the titles' text and design, double-click the title's clip on the Timeline or in the player. The setting panel will appear.
1. On the Text tab, edit your text, choose the title style, add the outline and the background by selecting these options.
2. On the Clip tab, change the duration of the clip and animation speed of a title.

3. To change the color of the style and switch to the Color tab, select a non-text element of the title in the player.

4. On the New Preset tab, save the title preset with the adjustments you made to use it in other projects.

5. Click Apply to save the changes.

Clip Editing

- 'é‘. Bebas Meue Bold

1. To change the position of a title on the screen, double-click a clip on the Timeline. In the player, you will see a frame appear around the

object. Drag the corners of the frame to change the size and drag the object itself to move it. To rotate titles, click and drag the top white dot
of the frame.

SB)
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- Move several objects at once by selecting them with the mouse cursor or by holding the Ctrl key and clicking the objects with the left mouse
button.

Timer

Add a timer

1. Click the Titles button on the left sidebar to open the list of available text styles.

2. Find the "Timer" title style. Use the search bar or click the Basic group to filter the styles.

3. Drag the Timer titles onto the title track of the Timeline. To change the length of the timer, drag the edges of the clip.

44 P

.- ee:"

Edit the timer

1. Double-click the timer clip on the Timeline.

2. Edit the text formatting on the Text tab, if needed.

3. Switch to the Timer tab.

4. Change the time format to the suitable one, for example, ss:zzz.

5. In the From field, set the starting time. If you select to set a countdown, it will also begin from the time you set in the From field.

Clip Editing (

Text Clip Mew Preset Timer —

Format: hh:mm:ss:zzz

From: 00:00:00.000

Countdown

Saving a preset

After you set up your title style, you can save it and use if in future projects.
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1. Double-click a title clip and adjust it to your preference. Then switch to the New Preset tab.
2. Name new preset.
3. Click Save.

You can find your titles on My titles tab.

Titles

My titles

Featurad T[TLE HEHE

(N SOME TEXT BERE

Stickers
Add stickers
1. Click the Stickers button on the sidebar to open the list of stickers.

Click a sticker to preview it in the player. If you liked a sticker, click the heart icon &4 to add the sticker to your favorites list.

2. Select the sticker and drag it onto the title track of the Timeline. All titles, callouts, and stickers go on the title track. Change the length of
the sticker to make it fit the clip.

Stickers

LRI 1
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Edit the sticker

1. Double-click to open the sticker settings.
2. Select the duration of your sticker.

3. Click Apply to save the changes.

Clip Editing

Chp

4. To change the sticker's position on your video, double-click the sticker clip. In the player, drag the corner of the frame around the sticker

to change its size, and drag the center of the frame to move the sticker. To rotate the sticker, click and drag the white dot at the top of the
frame.

5. Click Apply when you're finished.
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7] Transitions cannot be applied to stickers, but you can animate them.
Learn more: Animation

Animation

You can move objects any way you want and make creative appearances.

Add animation
1. Add the background onto the main video track.
2. Add the object you want to animate.

3. Click More and in the Video Editing choose Animation.

Animation

4. Select Easy mode to add quick and simple animation. To use the preset, just drag it on the clip.
To create your own unique animation, select Advancedmode.

Advanced mode
1. Select the clip you want to animate and place the position marker where you want your animation to be started.
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2. In the Animation panel, click Add Animation.

Animation
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Add Animation
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3. In the player, you will see a frame appear around the object. Use it to set the position of the object.

rd

- 0n the Timeline, two points will appear on the clip. They are called keyframes. The first point is the original position of the object. The
second point will be its end position after the animation. The distance between the two points determines the animation speed.

E Q'sro ']

Edit the keyframes
On the Timeline, double-click a keyframe to edit it. Adjust the animation:

Move the object on the player Use the frame of the object
Change the size Drag the corners of the frame
Rotate the object Drag the white dot at the top of the frame
Make it spin Use the Angle box on the Animation panel
Make the object fade in or out Use the Opacity slider on the Animation panel
Change the speed of your animation Move the keyframe point on the clip:
* Move the points closer together to make the animation go faster.
* Move the points farther away from each other to make it go slower.

LI I O
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- To add another keyframe, move the position marker to where you want to place it in the clip and click Add Keyframe on the Animation panel.
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Animation

Add Keyframe

Reset a keyframe
To make a keyframe go back to its original position, right-click the keyframe point on the clip and select Reset Keyframe in the pop-up menu.

Remove keyframes
1. To remove one keyframe, right-click the keyframe point on the clip and select Remove Keyframe in the pop-up menu.
2. To remove all keyframes and delete the animation, right-click any of the keyframe points and select Remove All Keyframes.

Pan and zoom

You can control the camera movement using two keyframes and smoothly move from one frame to another.
Add the Pan and Zoom tool

1. On the Timeline, select the clip that you want to zoom.
2. To open the Pan and Zoom, select More on the left sidebar and find the Pan and Zoom tool in the Video Editing.

Pan and foom

3. Select one of the presets and click it to apply.

vd

- This will add two keyframes to the clip. The camera will move between these two keyframes and you can set up camera movements from
one point to another.

4. To change the beginning keyframe, double-click the first point on the clip. Then, use the frame in the player to set the zoom level for the
starting point of the camera movement.

5. To change the ending keyframe, double-click the second point on the clip. Then, use the frame in the player to set the zoom level for the
ending point of the camera movement.
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Pan and Zoom

rd

- To change the length of the zoom effect, move a keyframe left or right. To move the zooming effect on the clip without changing its length
or other settings, move it along the clip.

rd

- If you want to add more camera movements, repeat steps 2-4 to combine other camera movements in one clip. For example, you can
zoom in on an object, pan across the frame with the same zoom level, and then zoom back out to 100%.

Add the Pan and Zoom effect to all the image clips automatically
1. Select necessary images on the Timeline.

2. Click Transition Wizard button on the panel above the Timeline.

3. Select the Pan and Zoom checkbox.

4. Click OK to apply the effect to the clips.

Ise this transition style tor all chps:

Mo transitions

04.000

v Enable Pan and Zoom effect

Remove zoom
To remove a pan or zoom effect, right-click a keyframe and select Remove All Keyframes to clear all zoom effects from the clip. To remove
only the selected keyframe, select Remove Keyframe.

Stabilizing video
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If you're filming with a handheld camera, it's likely that there might be some unwanted camera shake visible on the video, especially if you
walk or move while filming.

Stabilize a video
1. On the Timeline, select the clip you need to stabilize. To the process shorter, you can cut the video into smaller segments.
2. On the left sidebar, click the More button select Stabilization from the pop-up list.

Stabilization

stabiizabion too
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3. Click Stabilize to open stabilization options. The Stabilization window will open.

Stabilization

4. Set up stabilization with the following parameters:
Accuracy Affects the analysis precision of the video.

Shaking Sets how strongly the shaking is visible on the video.

To open the Advanced settings, click the Arrow button and set up stabilization with the following parameters:

Radius When a video is stabilized, each object is adjusted using the pixels from
the surrounding area. The radius affects how large that area will be. Use a
smaller value for more dynamic videos to avoid mixing objects together and
to preserve more detail.

Smoothing Limits camera acceleration. Higher values work best for more or less static
videos. Excessive smoothing may limit panning.

Edge Cropping Eliminates distortion artefacts like blurred areas from the video. There are
several options such as:

* None: the edges will remain as they are. Best results if there is little
shaking on the video.

* Fixed: the video is cropped to one size to cut off some of the edges.

+ Adaptive: whenever there is a lot of shaking, the video will zoom in so that
the distorted edges are not shown.

5. Click Stabilize to start processing the video. This may take a while depending on the length of your video and the selected parameters.
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Stabilization

Stabilize

6. To save the result, click Apply and you will replace the clip on the Timeline with the stabilized video.

A stabilized copy of the file will be created under "\My Videos\Movavi Video Editor\Stabilized". This copy will be used in the project. If you delete
the stabilized copy, you will lose all the changes made.

If you don't have enough space to save the stabilized copy, you can free some disk space and try again, or save stabilized copies on another disk:
1. Open the Settings menu and choose Preferences.
2. Switch to the Files tab.

3. Find the "Store stabilized videos in" box and click the button o on the right to choose another folder on a drive.
4. Click OK to accept the changes.
5. Try stabilizing the video again.

Highlight and conceal

This tool will help you to control the focus in the frame, and blur or darken parts of the video.

Apply the Highlight and Conceal tool to the video
1. On the Timeline, select the clip that you want to edit.
2. To open the Highlight and Conceal, click the More button on the left sidebar, and choose Highlight and Conceal in the Video Editing tab.

Highlight and Conceal
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4. Choose a shape for the mask: you can use a rectangular or an elliptical one.

5. Choose a masking effect: Blur, Matte (black cover-up) or Pixels. Use the options below to set up the mask
Opacity — makes the mask more transparent (for matte and blur);
Feathering — makes the edges of the mask softer (for matte and blur);
Size — changes the size of the pixels (for pixel masks only);
Outline — adds a white outline around the mask.

Highlight

Highlight

Qpacity:
Feathering:

Outline:

( Apply )

6. To change the size and shape of the mask drag its corners in the player, drag by the center of the mask to move it on top of the object.

o
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- If you want to cover up or highlight more than one object, click Add Mask at the top of the setting panel to create another mask.

H u;h' u;h'; and Conceal

Mighlght and Concaal
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. Click Apply on the Highlight and Conceal panel to save the changes.
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Chroma key

The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.

Add Chroma Key

1. Add the video or image clips that you want to use as the foreground and the background.

2. Select the foreground video and move it up, onto the Overlay track.

3. Double-click the foreground video to open Clip Properties.

4. To make the foreground video completely cover the background video, select the Overlap mode.

Clip Properties
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5. On the left sidebar, click the More button and in the Video Editing list find Chroma Key.

Chroma Key

6. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to remove. The color
you've picked will become transparent.
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Use more settings:

Tolerance Set how many similar shades of the selected color should also be removed.
Noise Choose how sharp the object's edges should be.

Edges Choose how thick the object's edges should be.

Opacity Set the transparency of the background

7. Finally, click Apply to accept the changes.

Chroma Key

Exporting videos
When you're done with your project, you'll need to export it as a media file to be able to play it on the devices. This section will guide you

through the process of exporting your project to a popular video format. If you want to find out more about other ways of saving videos, see
the following guides:

Export a video

1. To start saving the video, click the Export button under the player. The export settings window will open.
2. Choose a format for saving the video in.
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MOV

MPEG-1 ve Video to the Computer

MPEG-2
MKV

FLV

M2TS (H.264)

WebM

DVD (NTSC)

DVD (PAL)

GIF

Some formats allow you to choose between video codecs. If you don't know which format to choose, try using MP4. The MP4 format is
supported by most platforms and operating systems.

At lower resolutions, the file will be significantly smaller, however, the video will lose some quality due to the limitations of digital data
compression.

The GIF format is different from other formats in the list. It allows saving video as a mute animated image, which can then be played in some
image viewing programs or in any web browser.

3. If you want to change the resolution, aspect ratio, or other settings, click the Advanced button to view and edit the project settings. To
save the changes click OK.

Save Video to t

Restors Defaults

4. Name your file and choose a destination folder.

Save Video to the Computer
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In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the . To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or

enter the path manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.

5. Choose the quality of the video.

Save Video to the Computer

Quality: & Good High Highest

If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This
will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.

6. Click the Start button to begin processing the video file. This may take up to a few minutes.

Save Video to the Computer

Export only audio

This section will guide you through exporting just the audio track of your project.

Export an audio
1. Click the Export button in the bottom right-hand corner of the Editor to open the export settings window.

Save Video to the Computer
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2. Click on the Save Audio File tab in the left part of the Export window.
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Save Video to the Computer

3. Select the format you'd like to save the audio in.

Save Video to the Computer

While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to preserve high
audio quality, albeit taking up considerably more disc space. When choosing an output format, it is important to note the quality of the
original files: due to data compression limitations, digital audio cannot be restructured from very low quality files by saving them as FLAC
audio, and vice versa — high quality files may lose some of that quality when saved to MP3 format which is limited to 320 Kbps.

4. Name your file and choose a destination folder.

In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the . To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or
enter the path manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.

5. Click the Start button to begin processing the video file.

Save Video to the Computer

Export for devices

This guide will help you export your video project for playing on mobile phones, tablets, and other devices.

1. Click the Export button under the player to open the export settings window.

69


https://img.movavi.com/online-help/videoeditorplus/15/preferences_ve.htm

Save Video to the Computer

2. In the left part of the Export window click on the Save for Devices tab.

Save Video to the Computer

3. Choose a format.

On this tab you will find a number of different types of devices for which you can choose a format. You can choose between devices running

iOS (iPhone, iPad, iPad mini) or Android, Samsung Galaxy S6 and Galaxy S7, Google Nexus 6 and Google Pixel, as well as Playstation and Xbox
consoles. If your device is not on the list, choose Other.

iPhone

ipad / ipad mini Save Video to the Computer

Android

Other

You can select High or Highest quality to export the finished video with a higher bitrate. This will increase the output file size but will preserve
better quality. For most other projects, Good quality will provide a nice result at a small file size.
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Save Video to the Computer

Quality: ® Good High Highest

4. Name your file and choose a destination folder.

In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified
in the . To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path
manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.

5. Click the Start button to begin processing the video file. This may take up to a few minutes.

Save Video to the Computer

Export for TVs

This guide will help you export your video project for playing on Smart TVs.

1. In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

Save Video to the Computer

Sl g e £ 'lq,r,_-f :""’

2. In the left part of the Export window click on the Save for TVs tab.
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Samsung 10800

Save Video to the Computer

3. Choose your TV brand and the necessary resolution. If your TV is not on the list, choose Other 1080p TVs or Other 4K TVs.

Samsung 1080p
Sony 1080p

LG 1080p Save Video to the Computer
Panasonic 1080p
Philips 1080p
Apple TV

Other 1080p TVs
Samsung 4k
Sony 4K

LG 4K

Panasonic 4K
Philips 4k

Apple TV 4K

Other 4K Tvs

If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This
will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.

e Save Video to the Computer

(]

3

Quality: ® Good High Highest

g Fhihps 4K

4. Name your file and choose a destination folder.

In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified
in the . To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path
manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.

5. Click the Start button to begin processing the video file. This may take up to a few minutes.
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Samsung 1080p

Save Video to the Computer

Phihps 4K

Uploading online

After you finish your video, you can share it to YouTube, Vimeo or Google Drive right from the export window.

Upload online
1. Click the Export button to open the exporting window.

Save Video to the Computer

—

i ek S S5 B

2. In the left hand part of the Export window click on the Upload Online tab.

Upload to YouTube

3. On the Upload online tab select the service you would like to upload your videos to: YouTube, Vimeo or Google Drive.
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Upload to YouTube

4. Click Sign in. The authentication page will open in your browser.
Sign in to your account and click Allow to let Movavi Video Editor Plus upload videos.

Upload to YouTube

5. In the Export window, open the Resolution list and choose a resolution that suits your project.

Upload to YouTube

Upload to YouTube

1. Fill in the title and description for your video.

2. Add some tags to help users find videos by relevant topics. Separate tags with commas and add a number sign (#) before each one.
3. Choose a category to help viewers find relevant content.

4. Open the Privacy box and choose who you want to see the video:

Private - videos can only be seen by you and the users you choose.

Public - videos can be seen by and shared with anyone.

Unlisted — videos can be seen and shared by anyone with the link.

5. Click Upload to export your video.
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Upload to YouTube

Film & Arumation

edite

Upload to Google Drive

1. Fill in the title for your video.
2. Select a Google Drive folder where you want your video to be uploaded. You can create new folders in your Google Drive storage straight

in the export window.

3. Open the Privacy box and choose who you want to see the video:
Private — videos can only be seen by you and the users you choose.
Unlisted — videos can be seen and shared by anyone with the link.
4. Click Upload to export your video.

Upload to Google Drive

v @ GoogleDrive

I New folder

Upload to Vimeo

1. Fill in the title and description for the video.

2. Set the level of privacy:

Anyone — any person can watch the video.

Only people I follow — only people you're subscribed to can watch the video.
Only me — nobody, but you can access the video.

3. Select the resolution of the video and add tags.

4. Click Upload to export your video.

LPICRCES MM Resolution: 1080p

Privacy: Anyone

Des cnption:

Save and upload the video

Before uploading, the video will be saved as a file on your computer.

1. To change where the video file is stored, click Browse and select a folder.
2. Click Upload to begin saving and exporting the video.
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Upload to Vimeo

aiWideos\Mowvavi Library ¥ 1 Browse

Editor preferences

To open the preferences:
1. Click the Settings menu
2. Select Preferences.

The Preferences window will open. The preferences are organized into tabs. Click on a tab to open the relevant options.

Preferences

Sharing

English

v  Automatically check for updates
» I give consent to send anonymous usage stats to Movavi

Learn more

Use software OpenGL implementation

Play notification sound when exporting is finished

OK

3. When you're done, click OK to close the window and apply the preferences.

See also:

General preferences

Interface Language — to change the interface language, simply select the necessary language from the list and click OK to apply the
changes.

Automatically check for updates — select this option and you'll be notified whenever a new version is available. Updates within your version
are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.

I give consent to send anonymous usage stats to Movavi — check this box to let the program send usage statistics to our development team
and help us to fix all the problems in the program much faster. The data contains no personal information, will not be disclosed to third parties
and will be used for software improvement purposes only.

Use software OpenGL implementation — this option can be useful if your computer doesn't support the necessary OpenGL version and you
see an error message when you start the program.
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OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

If Movavi Video Editor runs without showing an OpenGL error message, this option is not recommended.

Play notification sound when exporting is finished — when saving a project as a media file, you'll be notified as soon as the process is
completed.

Preferences

Files Sharing Acceleration

English

v Automatically check for updates
v [ give consent to send anonymous usage stats to Movavi

Learn more

Use software OpenGL implementation

Play notification sound when exporting is finished

OK

File preferences

On the Files tab, you can find the options for storing and saving different kinds of files. You can change any of these folders to a different
location.

Save project files to — a folder for saving and opening projects. This folder will also store any autosave files for new projects. You can use the
autosave file to restore your work in case of an error or force close.

Save output videos to — a folder for exporting media files.

Store audio recordings in —a folder for the audio clips that you record in the Editor.

7] If you delete these audio files, the audio recordings in the project will also be unavailable.

Store stabilized videos in — a folder for a stabilized copy of the original when you stabilize a video.

v d

- Don't delete these files while you are working on the project, or you'll have to stabilize the files again.
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Preferences

General Files Sharing Acceleration

C:\Users! \Desktop
ave output videos to:

C:\Users) ‘Wideos\Movawi Library
Store audio recordings in:

Usersh \Music\Mowvavi Video Editor\Recorded Audio
Store stabilized videos in:

C:\Usersh, Wideos\Movavi Video Editor\Stabilized

Changing where the files are stored
Using a different folder might help if you don't have much disk space on your primary drive, or if you want to organize your media files in
another way.

1. Click the button with three dots o next to the folder you want to change.
2. A Windows Explorer dialog box will open. Choose the folder you want to save the files to.
3. Click Select Folder to use this folder.

Sharing preferences

On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.

To signin:
1. Click Sign In. The authentication page will open in the browser.

Preferences

General Files Sharing Acceleration

Sign In...

Sign In...

Sign In...

2. Sign in to your account.
3. On the next page, allow Movavi Video Editor Plus to upload videos to your account.
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Movavi Video Editor Plus wants
to access your Google Account
.

This will allow Movavi Video Editor Plus to:
B Manage your YouTube videos @

B WManage your YouTube account @

Make sure you trust Movavi Video Editor Plus

YOu can alway

Goaogle Account

Leamn about the risks

4. Return to Movavi Video Editor Plus. Your name will be shown in the Preferences window.

To sign out or use a different account:
Click Sign Out. After this, you will need to sign in again to upload videos.

Preferences

General Files Sharing

B YouTube =L

Acceleration preferences

If your computer is equipped with the necessary hardware, these options can help speed up encoding and decoding of media files, allowing
you to save your movies much faster and enjoy smoother performance.
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Preferences

General Files Sharing Acceleration

Enable Intel® hardware acceleration

Learn more

Optimize HD clips
Learn more
Store temporary optimization files in:

\Wideos\Movavi Video Editor\Preview Files

Ok

Enable Intel hardware acceleration
Accelerates video processing by up to 400% when working with H.264 and MPEG-2 video codecs.
This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics™ technology.

Enable NVIDIA hardware acceleration

With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50%
faster.

Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other
programs.

This option is only available if your computer is equipped with an NVIDIA graphics card that supports this technology.

Compatible graphics cards
NVIDIA acceleration supports GeForce, Tesla and Quadro graphics card series. You can find the full list of supported GPUs on NVIDIA®'s
official site:

Enable AMD hardware acceleration

With this option enabled, you can use AMD's graphics processing power for converting videos.

Using the graphics card instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering
while converting videos.

This option is only available if your computer is equipped with an AMD graphics card that supports this technology.

Fast Track HD Acceleration

Fast Track HD Acceleration provides smooth and fast program running. By enabling HD clips optimization in the Preferences menu you allow
the video editor to create copies of the project files in a smaller size and then use them in the project instead of the original ones. To enable
this feature you need to have free disk space, so the Editor can store and use the copies. Once you finish editing and begin export, high-quality
files will replace all the temporary optimization copies.

Troubleshooting

If acceleration options are unavailable:

Your computer might not have the right hardware.

If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the
manufacturer's website: | | AMD Download Center

Intel HD Graphics is a trademark of Intel Corporation.
NVENC is a trademark of NVIDIA Corporation.
AMD s a trademark of AMD Corporation.

Convert files with Video Converter

Using the Video Converter program, you can change the format of video, audio and image files, convert files to play on devices or prepare
files for uploading online.
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Video Editor 24 Video Converter - . a Screen Recorder

Capture from
cameras, VHS, TV

Watch video

Try Realluison . Video Editing
L]
Cartoon Animator Service

What can | do with the converter?
Convert video files to a different format
Convert videos for watching on devices

Convert videos for uploading online
Convert audio files
Change image format
Create a GIF from a video

How to use the converter?

Step 1: Open the Converter app Step 2: Add files
Use the buttons at the top to open the files you want to convert.
Step 3: Choose an output format Step 4: Edit and choose conversion options
Select the format you want to convert the files to. Make changes to the files before conversion.
Audio tracks
Subtitle tracks

Reduce size

Step 5: Choose the output folder Step 6: Convert!
Select the folder where the newly converted videos will be stored. Click the Convert button to start processing the files.

Launch the converter

To launch the conversion app:

In the Movavi Video Suite launcher, go to the Video tab. Then click Video Converter.

) & -
3% My programs ° J e Ko "o e
Q wy files - 2 >
y Use Our Video Editing Upgrade to Movavi How to Add Create Your Own Py
80 Al broarams Services > ", Unlimited Horror Effects Cartoons!
a0 prog s
Q) Favorites G) Video Audio 2] Photo

*  Video Editor # a Video Converter 24 a Screen Recorder
Launch Launch

, Capture from
cameras, VHS, TV

Gecata

£ Activate

% Try Realluison s Video Editing
'
Cartoon Animator Service

~ Recent projects and files

Except for videos in the Video Converter, you can also convert audio, images, photos, and other files.
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% Movavi Video Converter - O X

£} AI Upscaling

) use the program in a few simple steps |

(+)

Drag media files or folders here

224 | Qutput format: MP4 @}

Converting media files

Open files

1. Click the Add Media button at the top and choose the desired type of file.

2. A Explorer dialog box will open. Select the files you want to convert.

3. Click Open. The files will now be added to the file list.

4. Or drag and drop files into the program or click in the center of the main window.
Opening media

+ Add Media

Drag media files or folders here

Select files
Check the files you want to convert. You can remove converted files after they're done. To do it, click a trash can near to Selected files.

E: Mg H. 364 - Oniginal Size ﬂ‘
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Choose output format

In the lower half of the window, you will find tabs for any type of files and devices — Video, Audio, Images, Devices.
Popular is a tab with popular conversion formats. The used presets will be put into this tab too.

1. Click the desired tab, Video, for example.

2. Click the format you want to use. You can also type format or device name into the search field.

Video

3. For video, choose the preset with the codec and resolution that you want to use.

26 MB

MOV - Scale up to Full HD
1080p

MOV 19201080 H.264 Auto
MOV - Original Size

Same as input  H.264 Auto

- . Video
MP4

AvI

b MDA - Original Siee 'u-

Each preset displays information about the video, audio, and other output parameters that can help you choose the right one.
Learn more about file media streams and customizing presets.

MP4 H.264 - Original Size P
(M) superspeed )

MP4 Same as input H.264 Auto

Edit and rename the file

« If you want to edit one of the videos, click the Edit button next to it to open the Editor window.

+ To rename the file, click the pencil icon next to the output file name and enter the new one into the Output file name box. Then, click OK to
accept.

Learn more about Editing files
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Check output folder
* At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous folders
by clicking the check near the Save to... button.

« Finally, click the Convert button to start processing the videos. This may take anywhere from a few seconds to several hours, depending on
the size and number of video files.

b MOV - Original Size Q

Opening media
To begin converting media files, you will first need to open them in Movavi Video Converter.

Add media

1. Click Add Media at the top of the window.

2. Click one of the buttons to open files of that media type.

3. A Explorer window will open. Find the files you want to convert and click Open to add them to the queue. Or simply drag the files from any
Explorer window onto Movavi Video Converter to add them to the queue.
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+ Add Media A

E.E A ';j ':-I Wi ';j c0...

Add Audio...

|'I:I'L 'j 'j [:' I'l_.'r [:I

Drag media files or folder

Add Folder...

Drag and drop

Find the files you want to convert in Explorer and drag them onto the Movavi Video Converter window. The files will now be added to the
conversion queue.

Open File
ik E Thiis PC Videot

’]':_|.-."|:vr - Mew folder = - m ﬂ

# Quick access

f
V3 1 } [ This PC _ ' L
g Network . A

t MP4 H.2764 - Original size T Mionvavi Library Might Sky.mpd Orwil ini Tree-mp4

File name: | “Ciwl in Tree.mpd™ “Night Sky.mpd | | Al Video [".mpd:".avi;".mpeg;".

Choosing output format

After you've added media files, it's time to choose the output format for converting all of the files in the list. Follow the steps below to choose
a video output format.

1. In the lower half of the window, click the desired tab to see a list of formats. For example, Video

2. Click the format that you want to convert the files to. A list of presets for this format will appear. For example, MOV
3. Choose the video codec and resolution that you want to use.

To convert without changing the resolution, choose the preset marked with "Original size" or "Same as input".
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26 MB

MOV - Scale up to Full HD
1080p

MOV 19201080 H.264 Auto

MOV - Original Size

MOW  S5ame as input  H.264 Auto

1 MOV - Driginal Size T

MP4 H.264 - Original Size

I:: )}} SuperSpeed ::I

H.264 Auto

Choosing the right resolution

A video's resolution is its size in pixels, horizontally and vertically. It is usually listed as the width times height: 1920x1080, or just the height:
1080p. This means that the video is 1920 pixels long and 1080 pixels tall. The higher a video's resolution, and the more pixels it has, the more
detail it can preserve.

First of all, you need to know the original file's resolution. To do that, check the video information next to the file's preview. When you choose
the output resolution, select the same resolution to preserve the original quality, or choose a lower resolution to reduce the file size.

Advanced settings

If you can't find a suitable preset, you can select the necessary properties manually. Click the Customize button next to the 'Output format '
box to modify the video and audio properties of the currently selected preset.

Learn more

Compressing files

Compressing videos can help reduce the size of the output file by reducing their bitrate. When you compress a video, it loses some of its
original quality, but even a small bitrate reduction can make the file significantly smaller.

Open files
Open the files you want to compress.
Learn more

Choose the output format
The video's format and resolution play a very important role in the output file size.

1. Click the Video tab to see a list of video formats.

2. Click the format you want to convert the videos to.

Note: Some formats and codecs compress video better than others. If you're not sure which format to choose, use the MP4 format with the
H.264 codec for the best size to quality ratio.

3. From the format list, choose the resolution that you want to use.
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MOV - Scale up to Full HD
1080p

MOV 19201080 H.264 Auto

MOV - Original Size

MOW  S5ame as input  H.264 Auto

1 MOV - Driginal Size T

Choosing the resolution
A video's resolution is the number of pixels in every frame. A higher resolution can preserve more information and quality, but it also requires

more disk space. Select a slightly lower resolution if the video is very large. For example, you can convert 1080p videos to 720p.
Learn more

Compress video
1. In the file list, check the file's output size in the second column from the left.

2. Click the file size information to show compression options. There, choose the bitrate type.

Constant bitrate (CBR) allows you to get an output file with the exact size (recommended for DVD recording and streaming). During CBR
encoding, the bitrate or the number of bits per second is kept the same throughout the encoding process.

(Y 3 mB (Original)

File size: o

Quality: Original

Bitrate type: Constant

Convert sample .5 . min.

Apply bitrate to all files

Variable bitrate (VBR) allows you to reduce output file size up to two or three times saving the quality. But the file size cannot be predicted.
During VBR encoding process the bitrate of the media file will dynamically increase or decrease depending on the media files bitrate needs.
Use VBR unless you have a specific need for playback on a device that only supports CBR.

87



Y 2 mB (Original)

Set the preferred quality:
13 (Medium)

Smaller size Better quality

Convert sample .5 . min.

Apply bitrate to all files

3. Click Apply bitrate to all files in the compression box if you want to unify quality of the files.

If you want to check the quality of the output file without converting the whole file, click the Convert sample button. You can set the duration
of the fragment to the right of the button. The folder with the converted fragment will be opened automatically.

Convert
Click Convert to start processing the compressed file.

Converting DVDs

The era of the DVD disc is coming to an end, and not all homes now have a DVD drive. Make your favorite movies future-proof by backing
them up to your computer.

Open DVD

1. Insert the disc into your DVD drive. If you have an external DVD drive, connect it to the computer.

2. Click Add Media in the upper left-hand corner of the window.

3. Hold your mouse pointer over Add DVD.

4. Click the disc name in the menu that appears. If you don't see the DVD in the list, click Open DVD and find the DVD location.

-+ Add Media A

Open DVD...

Drag media files or folders here

L MOV - Original Size

Tip: some DVDs are protected from illegal copying and cannot be converted. Movavi Video Suite is not intended for copying protected media.

Choose video format

1. In the lower part of the window, click the Video tab to see a list of video formats.

2. Choose the group with the format you like.

3. Click that format and pick a video resolution. To convert with the original resolution, choose the line marked with "Same as input".
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1080p

MOV 19201080 H.264 Auto
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Choose files and streams (optional)
Many DVDs come with bonus clips, as well as a number of subtitle tracks. Select just the files you need to save disk space:

Bonus files
To remove bonus files that you don't need, click the # icon to the right of the video.

Audio tracks

1. Find the audio information in the right-hand part of the file list and click on it to open the list of audio tracks.
2. Deselect the audio tracks that you don't want to keep.

Learn more about audio tracks

Subtitles

1. Find the subtitle information in the right-hand part of the file list and click on it to open a list of available subtitles.
2. Choose the subtitle track that you want to keep.

Learn more about subtitles

b MOV - Driginal Size T

Convert

+ At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous folders
by clicking the check near the Save to... button.

* Finally, click the Convert button to start processing the videos.
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t: MOV - Criginal Size T Save to... : Convert

Creating GIFs from videos

Open a video
1. Click Add Media in the upper left-hand corner of the window and choose Add Video from the pop-up menu.
2. Find the video you want to turn into a GIF and click Open.

+ Add Media

+

Drag media files or folders here

Trim the video
Usually, GIFs are pretty short, which means you'll need to trim the video to show just the important part.
1. Click the Edit button next to the video in the file list to open the Editor window.

PNG BMP TEF G

t: Madium GIF €

2. Cut the video as you need.
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3. Click Save and Close to finish trimming and close the editor.
Learn more about trimming files

M 4 P »

D003, 256

Choose GIF format

1. In the lower half of the window, click the Images tab to see image formats.

2. Click GIF to see GIF conversion options.

3. Choose a size for your animated GIF. For example, "Medium GIF".

4. (Advanced) To change the frame rate, click the Customize button next to the output format at the bottom to customize the selected
preset. In the settings window, choose the frame rate you need and click OK. Higher frame rates will make the movements seem smoother,
but will increase the GIF's file size.

Medium GIF

GIF  Fit to 500x376

Large GIF

GIF Fit to 700x526 GIF

- Madiam GIF 3

Save the GIF

1. At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous
folders by clicking the check near the Save to... button.
2. Click Convert to save your animated GIF.

Merging files
Add files

Click Add Media in the upper left-hand corner and choose Add Video from the pop-up menu. Open the files you want to merge.

+ Add Media

+

Drag media files or folders here

o

B (. @

Merge files

1. The files will appear in the joined video in the same order as they are shown in the list. Drag the files with your mouse to the right order.
2. Select the Merge files option at the bottom of the window. All the files in the list will now be queued for merging.

91



1 MOV - Driginal Size T

Convert

1. Select an output format for the new video. See also: Choosing output format
2. Click Save to... box and choose where to save the output video.

3. Click Convert to start joining the files.

Troubleshooting
If you see an error after selecting the Join files option, make sure that all of the files in the list have the same number of audio tracks. Click

the audio information and disable the extra audio tracks. See also: Choosing audio tracks

Customizing presets

After selecting a preset, you can manually modify it to change any output properties. To do that, click the cogwheel button next to the Output
format box to open the settings for the selected preset.

qK

To see more settings, click Show Advanced at the bottom of the settings window.
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Preset: MOV - Original Size

Video Audio

Codec

Frame size Width (px) Height (px)

Original size

Resize quality Resize method

Bitrate type
Auto
Frame rate

Auto

Show Advanced

Two Pass Encoding
Encoding videos in two passes means that the encoder will go over the media file twice: first, to analyze the file and then to convert it using
the collected data. This takes extra conversion time, however it allows for a higher output quality and possibly a slight reduction in file size.

To enable two pass encoding:

1. Inside the Settings window, click Show Advanced to show the encoding settings.
2. Under Encoding type, choose Two Pass.

3. Click OK to accept the changes.

Tune settings
You can use Tune for advanced settings of H.264 videos.
Tune optimizes the preset settings for the best quality depending on the type of the input video:

* Film - for action movie content

+ Animation - for animated cartoons

- Grain - for grainy, detailed video material

- Stillimage - for still image footage

* PSNR - for achieving high peak signal to noise ratio
* SSIM - optimization for structural similarity

» Fast Decode - for faster decoding

« Zero Latency - for streaming video.

Choosing an image format

Most applications and web services are limited to just a few image formats, and working with rare formats usually requires expensive
software. Convert images to be able to use them wherever you like!

Open images

1. Click Add Media in the upper left-hand corner of the window.
2. Click Add Images in the pop-up menu.

3. Choose the images you want to convert and click Open.

Choose format

1. In the lower half of the window, click the Images tab to see a list of image formats.

2. Click the format you want to use.

Note: not all formats support transparency. If the images have transparent areas, choose the PNG or BMP format.
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, PNG BMP

Reduce the file size (converting to JPG only)
Click the file size to open settings, then drag the slider to reduce the image size.

174 KB

a5 | (Y High quality A

Quality: High

File size: 78 KB

Edit image (optional)
You can quickly fix or improve any images before converting. To do that, click the Edit button next to the image you want to adjust.

Learn more: Applying a watermark | Enhancing colors | Cropping videos and images

Resize images (optional)
To batch resize the images:

1. At the bottom of the window, click the cogwheel icon o next to Output format.
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2. Click the box under Frame size and choose a size that you want to use for all images, or choose any of the following and enter the size into
the width and height boxes on the right:
Custom: scales the images to exactly the size you specify.
Smart fit: scales the images up or down as close as possible to the specified size without changing the proportions.
Up to size: scales the images down as close as possible to the specified size without changing the proportions. Images smaller than
this size will remain unchanged.

To allow changing the image proportions, click the link icon next to the width and height boxes: 9 - locked, 9— unlocked.
3. If the new size is different from the original image proportions, choose a resize method for your images:

Letter box — unused space will be filled with black.

Stretch - the image will stretch to fill the entire area.

Crop — the image will be resized to fill the entire area, and overflowing edges will be cut off.

4. Click OK to accept the changes. If you want to preview the result, click the Edit button next to an image.

Preset: IPG

MIPEG

Frame size _ Width (px) Height (px)

1920 x 1080 1920 ¥ 1080
Resize quality Resize method

Good (Fast) Letter Box

Save and convert

At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous folders
by clicking the check near the Save to... button.

Finally, click the Convert button to start processing the images.

Choosing an audio format

Even though MP3 is the most commonly used format, you may also encounter other formats, such as AAC or FLAC, which can preserve
audio quality better, but aren't supported by all devices. Converting audio will not only let you play music on any device or player, but also
organize and compress your media library.

Open music

1. Click Add Media in the upper left-hand corner.

2. Click Add Audio in the pop-up list.

3. A Explorer dialog box will appear. Choose the audio files you want to convert. Or simply drag the audio files onto the converter window.

Choose audio format
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1. In the lower part of the window, click the Audio tab to see the list of audio formats.
2. Click the format you want to convert the audio to.
3. Choose the bitrate that you want to use. To convert without changing the bitrate, choose the preset marked with "Original bitrate ".

Bitrate - the bitrate reflects the amount of data in kilobits that is played back each second (measured in kbps). Higher bitrate usually means
higher audio quality as well as larger file size, as extra data needs to be stored within the file. For audio presets, the bitrate is listed next to
the format. When you convert a file to lower bitrate, the extra bits of data are irretrievably lost, meaning that you cannot increase quality by
converting audio to a higher bitrate, because the file no longer contains the data that can be used to restore higher quality.

n oo

MP3 - 320 kbps

MP3 Mo video MP3

MP3 - Original Bitrate .
MP3 Mo video MP32

Audio

o "o

To] -...' f |ﬂC

it: MP3 - Origingl Bitrate  GF

Edit audio (optional)
Rename file
Renaming media files helps keep the music library in order.

1. Click the pencil icon 9 next to the file you want to rename.
2. Enter the file's new name.
3. Click OK.

Normalize and manage volume

If some of your music files are quieter than others, you can normalize their sound so you don't have to adjust the volume every time you
listen to them.

1. Click the Edit button next to the file you want to normalize.

2. The Editor window will open. There, switch to the Audio tab.

3. Adjust the volume level or select the Normalize volume option.

4. Click Save and Close.

Adjusting volume

Convert and upload
1. At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous
folders by clicking the check near the Save to... button.

2. If you want to upload the music to iTunes after converting, click the sharing button e at the top of the window and select iTunes from
the pop-up window.
3. When you're ready, click Convert to start the audio processing. Your files will be ready in a few minutes at most.

it MP3 - Grigingl Bitrate O
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Devices

Converting videos for devices such as smartphones and tablets is quick and easy: all you need to do is connect the device and the program
will suggest the recommended format and resolution for it.

Open files
Drag the files you want to convert onto the converter window.

+ Add Media

Drag media files or folders here

Connect the device
Connect the smartphone or tablet to your computer using a USB cord.

Confirm the device
1. Once the device is recognized, a dialog box will appear with the device name and the recommended preset. Check that the device name

matches your device. If the dialog box doesn't appear, click the Device Detection @ button to the right of the search bar.
2. If the device is correct, click Use These Settings to use the recommended output format, resolution, and other parameters.

u want
or this device?

iPhone 5

Don't show when I connect this device

Use These Settings

Several devices are listed

Sometimes, the device detection box shows a list of several devices. This can happen if you have more than one connected device, or with
some devices that are very similar and can't be identified precisely. In this case, open the Choose your device list and select the device
model that you want to convert for. Then, click Use These Settings to use the recommended format, resolution, and other settings.

Device was not detected

- If the dialog box does not appear, try clicking the Device Detection button to the right of the search bar.
* Try reconnecting the device and wait for the system to detect it.

- If that doesn't help, you can still find a preset for your device manually on the Devices tab.

The wrong device was detected

If the dialog box shows the wrong device, and that device isn't also connected to your computer, you can still find it manually on the Devices
tab of the preset list.
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Save and convert

1. At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous
folders by clicking the check near the Save to... button.

2. Click the Convert button to start processing the videos.

3. After conversion has finished, upload the videos to your device and enjoy.

‘l J— HLAWIEL

Disabling device detection

If you don't want to use device detection for any devices:

1. Click the Settings button and choose Preferences.

2. In the Preferences window, disable the "Recommend output format for connected devices" option.
3. Click OK to apply the changes.
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General Conwversion Acceleration

Language: English

Automatically check for updates

I give consent to send anonymous us:

retect low volume in files

Show tutorial panel

Cancel

Disabling detection for one device

If you don't want the device detection window to appear whenever you connect a specific device:
1. Connect the device and wait for the Device Detection window to appear.

2. Select the "Don't show when | connect this device" option and close the window.

Apple iPhone 5

iPhone 5

v Don't show when I connect this

Use These Settings

Media streams

Every media file is made up of streams for each data type. A video can contain a video stream, a couple of audio streams, and several

subtitle streams. When converting files, you can find the information about these streams in two columns on the right. Here, you can manage
the streams that end up in the output file.
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Owl in Tree.mp4 ) Mo subtitles

™ 3 MB (Original) P AAC 3 Kbps Stereo

qK

To get more details, right-click the file and choose File Information from the pop-up menu. Here, you can see all the information about the
original file's video and audio streams.

File format: MP4

Duplicate
Video stream

Remove
Codec: H.264

Remove All Width=Height: 1280 x 720
Aspect ratio:

SETETLE Frame rate:
Duration:

File Information
Bitrate: 1469 Kbps

Audio stream

Codec:

2

Channels:

Sample rate: 44100 Hz

Duration:

Compress video

You can compress a video to reduce its output file size by sacrificing some of the quality. To do that, click the output file size and move the
slider to the necessary file size while keeping an eye on the quality.

Compressing videos

Choose audio tracks

If a file comes with a number of audio tracks for different languages, you can keep just the ones you need. To do that, click the audio stream
and deselect the audio tracks that you don't want to keep.

Choosing audio tracks

Choose a subtitle track

When you convert videos, you can permanently overlay subtitles on top of the video. To do that, click the subtitle stream and choose or add
the subtitle track that you want to use.

Choosing a subtitle track

Audio tracks

Choose audio tracks
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In the rightmost column of the file list, click the audio track information box. The audio track list will appear. In the box with the audio tracks,
deselect the audio tracks that you don't want to appear in the output video. If you want to completely remove audio from the file, select the

No Audio option. You can remove audio from all the files in the list by checking the Apply to all files box. You can also apply an audio track
to all files.

B i Tree mpd e (o o subbtbes
*> Dol dy MP3 128 Kbps Stereo A J
Select audio tracks:

Mo audio

. ¥ MP3 128 kKbps Stereo

MP3 128 Kbps Stereo

v Apply to all files

Note: not all formats support multiple audio tracks. The table below shows the maximum number of audio tracks for each format:

3GP 1
AVI 16
DVD 8
FLV, SWF 1
MKV 16
MOV 16
MP4 16
MPEG-1, MPEG-2 16
oGV 1
WebM 16
WMV 16

Subtitle tracks

When you convert videos, you can permanently overlay any subtitle track onto the original video. This can be useful if you're watching videos
on a device, or your player doesn't support subtitles.

Choose a subtitle track
In the rightmost column of the file list, you can see the subtitle and audio track information for each file. Click the information next to the

subtitle balloon e to open the list of subtitles. In the subtitle list, click the subtitle track that you want to use.

You can choose soft or hard subtitles:

Softsubs are stored as a separate track and you can add several subtitle tracks to a single file. All the subtitle tracks will be saved if you
choose All subtitle tracks option. The option available when converting to MKV only, and you cannot edit this type of subtitles.

Hardsubs are permanently drawn on top of the video and cannot be turned off, but they are guaranteed to be visible in any player. Choose
subtitles you want to embed from the list. Before embedding, you can edit the subtitle track.
Learn more about editing subtitles

101



Add subtitles to the output video

+ Add v }{ Edit

Mo subtitles
® All subtitle tracks
Embed subtitles:

Arabic [Arabic] (SUBRIP) Ry
oy

Apply to all files

Adding subtitles

To add your own subtitles that aren't stored inside the original file, click the Add button above the subtitle list and then open the subtitle file
that you want to add. You can use *.srt, *.ass, *.smi, or *.ssa subtitle files. Or you can search for subtitles online.
Learn more about online subtitle search

Applying a subtitle track to all files

Choose a subtitle track and select Apply to all files. This function works only in case you have files with the same quantity of subtitle tracks,
for example, it is a series.

Online subtitle search

Open online subtitle search
In the rightmost column of the file list, you can see the subtitle and audio track information for each file.

1. Click the information next to the subtitle balloon e to open the list of subtitles.
2. Click Add and then Search online...

+ Add

(Y Choose file...

@ search online... .

Search and download subtitles
1. Type a movie or series title into the search field.

2. Select a language you want to search subtitles for.
3. Click Search.
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4. Choose a desired subtitle track in a list of search

Title: Harry Potter
Language: English . O Advanced search .

results.
5. Click Download and Add. The subtitles will appear in the list of subtitles.

Title: Harry Potter @ search

O Advanced search

H.P.3-Pni vDrip-a
Harry.Po kaban.2004.720p.BluRay.DT
otter. The.Half.B nnce. TS }- STG.sr
Harry.Potter.and.the.Order.of. the.Phoenix
*otter.and. the . Half.Blood.Prince
Harry.Potter.and.the.Deathly.Hallows.Part.1.2010
Harry.Potter.and.the.C ), ¥4 -ESIR.ENG.srt

H.P.1-Philo

f.Potter.and.the.D rart.1.(20 AD-D-Z0M3.5rt .
3 pownload and Add

Check and embed subtitles
1. You can check the subtitles by playing the file. Play and click After to see if it works right.

2. If everything is okay, your next step is to embed the subtitles into the video so that they are visible in any player. Before you embed
subtitles, you can edit them.

Learn more about subtitle types | Learn more about editing subtitles
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Add subtitles to the output video

_+_ Add W \L‘ Edit

® Harry.Potter.a...G.sr

Apply to all files

Extracting subtitles

1. Click on the subtitles field next to the video you want to extract subtitles from.
* Make sure to choose the video format.

3 MB

wnreersf G Dutch [Dutch] (SSA) A

Add subtitles to the output video

+ add

Mk Edi

2. In the pop-up menu, click the Extract subtitles into a separate file button.
* Now, the file with the extracted subtitles will be saved by default in Movavi Library folder.
* The file will be automatically shown in folder at the end of the extracting process.

Editing media files

If you need to make some quick edits to the file before converting, click the Edit button next to the file that needs editing or Tools, and then
apply the necessary adjustments in the editing window.

You can apply tools and compare videos before and after editing. To do this, use any tool and switch between modes using the Before and
After buttons under the playback window. For example:
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Trimming videos
If you only want to convert a part of the video, you can trim off the parts you don't want from the beginning and end of the file.

Learn more about trimming videos

13 14 15

. i

TR EREERRREE
v/ ~

Trimmed video - 30 sec.

lllllll.lllllllll
Original video - 5 min.
Joining videos

If your video footage is in several different files, you don't need to use a full-function video editor to join them together.
Learn more about joining files

Joined videos

Rotation and cropping videos
Nobody likes videos with the wrong orientation! This can be easily fixed with the Rotate tool which lets you rotate and flip videos or images.

Learn more about transforming videos

)

Left to right: original image, rotated 90° clockwise, rotated and flipped horizontally

Cropping a video can change the video's aspect ratio to remove any black bars around it; you'll be able to use the entire screen when
watching the video. Cropping a video or image can also help to remove unwanted images from the edges of the screen (for example, if

there's a dumpster at the edge of an otherwise beautiful video!) or draw attention to the center of the frame.
Learn more about cropping

Cropplng a video |
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Adding a watermark

Adding your name or logo on top of the video will make sure nobody else can take credit for your videos.
Learn more about watermarking

Original video; image watermark; text watermark.
Adjusting colors
Using Movavi Video Converter, you can make quick color adjustments to your videos and photos. Use automatic adjustments for fast
enhancement, or adjust the hue, brightness, and saturation manually.
Learn more about video adjustments

Before and after adjustment

Adding effects

You can add effects to your video! Video Converter has some simple effects as removing fish eye, sharpening, vignette, and more.
Learn how to add effects

Before and after effects

Enhancing audio

Many movies have problems with volume, where the dialogue is too quiet and action scenes blast at full volume. To combat this, you can
normalize the file's audio track using Movavi Video Converter, or adjust the volume level manually.
Learn more about audio enhancements

Trimming files

Enter edit mode
Click the Edit button next to your file and switch to the Trim tab. Here, you can trim your file or just split it into segments.

Cut out a part of the video:
1. Move the position marker to the beginning of the segment and click the scissors button.
If you're trimming the file from the beginning or end, skip to the next step. You'll need a single cut for it.

4 4 P »

0003356

2. Move the position marker to the end of the segment and click the scissors button again.
3. Click on the fragment to select it and click the trash can button to remove it.
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4. When you've removed all the parts you don't need, choose how you want to convert files. You can convert files as a single file, and the
segments will be merged, or you can convert them separately.

Save segments:

® As 3 single file

As separate files

Ol 011,132

+

5. Then, click Save and Close to close the editing window.

You can also save each file of the list by clicking the floppy icon@.

Cancel trimming
- If you want to delete a cut marker, click a cross icon Ed near the marker.

* If you want to restore a deleted segment, click Restore @ in the segment list.
* If you want to go back to the original length, click Reset on the Trim tab in the editing window.

Precise positioning

To set a cut marker more precisely:

« Click on a cut marker to select it and move it along the seek bar to change the cut position.

* Click the Previous frame or Next frame button to move the position marker by exactly one frame.
* You can also zoom in the Timeline or set the exact time of the cut.
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Rotating video

Enter edit mode
Click the Edit button next to the file you want to rotate or select Rotate in the Tools tab.

Rotate or flip the file
1. Click one of the buttons to rotate or flip the file. The rotation buttons will rotate the file by 90 degrees with each click.

2. Click Apply to confirm the changes. If you want to rotate or flip all of the files in the same way, select the Apply to all files option.
3. Finally, click Save and Close to close the editing window. Now, you can proceed to converting the files.

4 4 P > »

Saving without conversion

You can rotate a file and save it without conversion. The Rotate without conversion option is available only for MP4, MOV, M4V-files with no
applied tools.
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To do this, take the steps above to rotate a file and then click Save without conversion button.
When the saving finished, click Save and Close.

Rotate and Flip

Flip horizontally Flip vertically

ave without conversion

e in the original format quickly
and without any quality loss.

If you have any tools applied, click the broom icon and then Reset applied tools. The Save without conversion button will be available.

Rotate and Flip

tools are applied:

- Effects

Reset applied tools 1 Cancel .

Flip nonzontally Flip vertically

ave in the original format quickly
and without any guality loss.

Cropping video

Cropping a video can help you remove parts around the edges or fix the video's aspect ratio.

Enter edit mode
Click the Edit button next to the file you want to crop or select Crop in the Tools tab.

Crop your file

1. Drag the edges of the frame to change its size, and drag by the center of the frame to move it relative to the entire video.

- If you want a specific size, enter it into the width and height boxes.

- If you want to crop the video to a specific aspect ratio, make sure that the Maintain aspect ratio option is enabled and choose the
proportions from the box below.

2. Click Apply to accept the changes.
3. Click Save and Close to close the editing window, and then convert the files for the changes to take effect.
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Adding a watermark

Use the watermarking tool to overlay any text or image over your videos and images.

Enter edit mode
Click the Edit button next to the file you want to apply a watermark to or select Watermark in the Tools tab.

Apply the watermark

Text watermark

1. On the Watermark tab, click the Text button.

2. Enter the watermark text into the box.

3. Click the buttons under the text box to change the font, text color, and outline color.
4. Move the Transparency slider to make the text more see-though.

Watermark

4 4 p I »

Image watermark
1. On the Watermark tab, click the Image button.

2. Click the folder icon 0 and choose the watermark image you want to use.
3. Move the Transparency slider to make the image see-through and less distracting.
4. By default, the image will keep its original proportions. To change the proportions, deselect the Maintain aspect ratio option.
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Transparency
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Move the watermark

In the player, move the watermark to the necessary position.
1. Drag at the corners to change the size of the watermark.
2. Drag at the center to move the watermark.

4 4 p I+ »

Exit edit mode
Click Apply to accept the changes. If you want to batch-process your files, select Apply to all files to apply the same watermark to other files

in the list.
Editing subtitles

Enter edit mode
Click the Edit button next to the file you want to overlay subtitles to or select Subtitles in the Tools tab.

Select subtitles

You can choose soft or hard subtitles.

Softsubs are stored as a separate track and you can add several subtitle tracks to one file. All the subtitle tracks will be saved if you choose
this option.

Note: Not all formats support softsubs. There are also less editing options: you can't change position and synchronize them with video. They
are also not displayed in the preview window.
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Hardsubs are permanently drawn on top of the video and cannot be turned off, but they are guaranteed to be visible in any player.

- If the subtitles are built into the file, select the necessary subtitles from the list.
If the subtitles are stored as an external file, click Add > Choose file... and open the subtitle file. You can use *.srt, *.ass, *.smi, or *.ssa
subtitle files. Or you can find them online.

12

Subtitles

[Russian].srt (SUBRIF)

Mo subtitles

Embed subtitles:
[English].srt {SUBRIF)

® [Russian].srt (SUBRIF)
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Set up the subtitles

Subtitle encoding
If the subtitle text looks scrambled, try changing the subtitle encoding: open the list and choose the language or character set the subtitles
should be in.

Position

Use the Position box to change where the subtitles appear on the screen:

1. Open the Position box and choose which edge the subtitles should snap to (e.g. top or bottom).
2. Use the slider below to move the subtitles relative to the selected position.

Synchronization

If the subtitles are out of sync with the video, use the synchronization box to advance or delay subtitles by a specific time in seconds and
milliseconds. Positive values make the subtitles appear later, and negative values make them appear earlier.

Example:

-0.100 - the subtitles will appear 100 milliseconds sooner.

1.200 - the subtitles will appear 1 second and 200 milliseconds later.

Synchronization:

4 4 P » » 0.00

Edit the subtitle display
You can also change a font, its size and color, fill and outline. Find these settings under the selected subtitle track.
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Exit edit mode
Click Apply and then Save and Close to apply the changes. When you convert the video, the selected subtitles will be permanently shown

over the video.
Adding effects

You can add effects to your video. There are seven simple effects in Movavi Video Converter.

Enter edit mode
Click the Edit button next to the file you want to apply effects to or select Effects in the Tools tab.

Apply effects
1. Click the preview icon to add an effect. You can apply several effects simultaneously.

2. Click Apply to accept the changes. If you want to batch-process your files, select Apply to all files to apply the same effects to other files
in the list.

3. Finally, click Save and Close to close the editing window.

4 4 P >

Adjusting colors
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Enter edit mode
Click the Edit button next to the file your file and switch to Adjustments tab or select Adjustments in the Tools tab.

Adjust the colors:

1. Drag the sliders to change the brightness, contrast, hue, and saturation of the photo and video.

2. Auto contrast option sets up brightness and contrast of a video or photo.

3. Use the Magic Enhance option the automatically fix the brightness, contrast, and saturation of the video or photo.
4. If the colors look unnatural, try the Auto white balance option.

Remove noise

1. Move the Noise level slider to reflect the amount of noise you can see in the preview. The more noise you need to remove, the higher the
Noise level.

2. Select the Noise removal option.

Adjustments

i 4 P » »

Exit edit mode

1. When you're satisfied with what you see in the preview, click Apply. To batch-process other files in the list with the same adjustments,
select Apply to all files.

2. Finally, click Save and Close to close the editing window.
Adjusting audio

Enter edit mode
Click the Edit button next to the file your file and switch to the Audio tab or select Audio in the Tools tab.

Adjust the volume

1. To change the volume of the whole file, drag the Volume slider to the necessary level, where 100% is the original volume.
2. If parts of the file are too quiet, select the Normalize volume option to make them louder.

Remove noise
1. Select the Remove noise option.
2. Drag the Noise level slider to set the amount of noise you can hear in the file.
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Exit edit mode
1. When you're finished, click Apply to accept the changes. To fix the volume for all the files in the list, select Apply to all files.
2. If you don't need any further editing, click Save and Close to close the editing window.

Low volume detection

When you add files to the converter, it will check the volume of the files and recommend steps if the volume is too low.
Find low volume files

1. The converter will mark quiet files with the "Low volume" tag. Click the tag to see the recommended course of action.
2. A message will appear, recommending volume adjustment. Click Boost Volume in the message to open the audio adjustments.

() Low volume

7 Looks like this file's audio is too quiet. Would you like to adjust
the volume?

. Boost Volume ( Close )

Boost volume
The Normalize volume option will already be selected for you. Play the file to check the new volume level. If you need more volume
adjustment, use the Volume slider to set the necessary volume level. Click Apply once you're satisfied with the new volume.
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When you're finished, click Save and Close to return to the main window.

Uploading files to iTunes

Adding converted videos and music to your iTunes library will allow you to play them on any of your devices connected to the same iTunes
account.

Before you start
To upload files to iTunes, you will need iTunes 6.0 or higher installed on your computer.
Download iTunes

Prepare the files

1. Open the files you want to convert.

2. Choose an output format. Choosing output format
3. Edit the files. Editing media files

Choose iTunes uploading
1. Click the the sharing button at the top of the window.
2. Select iTunes from the pop-up list.

iTunes

Convert files
Click Convert to start processing your files. After conversion is completed, the files will be uploaded to your iTunes cloud storage.

iTunes® is a trademark of Apple Inc.

Accelerating conversion

Here are some things you can do to convert videos even faster.

Take advantage of your hardware
Movavi Video Suite is optimized for the latest hardware, allowing you to use your computer's full potential when converting videos.

Enabling acceleration
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To enable these acceleration options, click the Settings button in the converter window, and choose Preferences from the pop-up menu. In
the preferences, switch to the Acceleration tab and select the available acceleration options.

Learn more about SuperSpeed Learn more about NVIDIA acceleration Learn more about Intel acceleration Learn more

Intel HD Graphics is a trademark of Intel Corporation.
NVENC is a trademark of NVIDIA Corporation.

SuperSpeed conversion

SuperSpeed mode allows you to convert video files much faster than usual without losing any quality. When you convert videos, encoding the
video from one codec to another takes the most time. If you don't need to change the video codec or resolution, the video data can simply be
copied to the new file, without having to convert it. This is also sometimes called remultiplexing or remuxing.

When can it be used?
SuperSpeed mode can be used any time when the video stream in the output file is the same as the original:

* The output codec is the same as the video codec in the original file (e.g. when converting MKV files with the H.264 codec to MP4 files with
the H.264 codec)

* The output resolution is the same as the original

* No video adjustments are used. This includes stabilization, video adjustments, denoising, subtitles, watermark, crop, and rotation.
* No video compression is used.

* You can still enjoy SuperSpeed conversion when trimming files.

How to use SuperSpeed conversion
To use SuperSpeed conversion mode, choose output presets marked with the SuperSpeed badge:

MOV - Original Size

l::: M) superSpeed :::I

MOV Same as input  H.264 Auto

This can be a video format or a device preset that has the same codec and resolution as your original files.
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Intel® Hardware acceleration

If you have one of the latest Intel processors, you can use the built-in graphics chip to accelerate conversion of H.264 and MPEG-2 video.

Intel hardware acceleration

* Accelerates video processing by up to 400% when converting H.264 and MPEG-2 video codecs.

* This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics™ technology.
» When choosing an output format, look for presets marked with the Intel HD GRAPHICS badge.

Compatible processors
Intel hardware acceleration is available on Intel® Core™ i3, i5, and i7 processor series. For a full list of processors that support integrated
graphics, please consult the Intel support center.

How to use Intel acceleration
You can enjoy Intel acceleration when converting videos to H.264 and MPEG-2 codecs. When selecting an output format, choose formats
and presets marked with the Intel® HD GRAPHICS badge. Conversion to these output formats will be accelerated.

MOV - Original Size

MOV  Same as input  H.264  Auto

Troubleshooting:

Can't enable Intel hardware acceleration

If the Intel hardware acceleration option in Movavi Video Converter preferences is unavailable:

* Check that your processor is compatible with Intel hardware acceleration. To do that, open the Control Panel, go to System and
Maintenance, and choose System. Find the processor information and make sure that you have an i3, i5, or i7 Intel processor.

» Update the Intel processor drivers. You can find the newest version at Intel's official website here. We recommend only downloading drivers
and other software from trusted sources.

* In order for the graphics acceleration to work properly, there needs to be a monitor connected to the graphics card port. Connect the
monitor and make sure it is functioning properly, then try enabling Intel® hardware acceleration again.

Problems while converting using Intel® hardware acceleration

If the video conversion process is taking longer than expected, or there are defects in the output video file:
» Try updating the processor drivers. You can find the newest version at Intel's official website here.

* Try disabling Intel acceleration in the preferences.

Intel HD Graphics is a trademark of Intel Corporation.

NVIDIA® Hardware acceleration

If you have one of the latest NVIDIA® graphics cards, you can use its graphics processing power for converting videos. Using the graphics
card instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering while converting
videos.

Convert using NVIDIA GPU

+ With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50%
faster.

+ Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other
programs.

* This option is only available if your computer is equipped with an NVIDIA graphics card that supports NVENC™.

* When choosing an output format, look for presets marked with the NVIDIA NVENC badge, depending on the acceleration technology
supported by your graphics card.
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MOV - Original Size

MOV Same as input  H.264 Auto

Compatible graphics cards

NVIDIA acceleration supports GeForce, Tesla and Quadro graphics card series. You can find the full list of supported GPUs on NVIDIA®'s
official site: NVIDIA NVENC supported GPUs
Note: NVIDIA acceleration does not support mobile graphics cards.

Troubleshooting

How do I find out which GPU my computer has?

1. Right-click on your desktop and choose Display settings

In the Display settings window that appears, click Advanced display settings. This will open your GPU's properties.

The Enable NVIDIA GPU Acceleration option is unavailable
If you can't enable NVIDIA acceleration, try updating your graphics card drivers.
NVIDIA Download Center | Detailed Instructions

Problems while converting video with NVIDIA GPU acceleration

If the video conversion process is taking longer than expected, or there are defects in the output video file:
+ Try updating the graphics card driver. Detailed instructions

* Try disabling NVIDIA GPU acceleration on the Acceleration tab of the preferences.

AMD Hardware acceleration

If you have one of the latest AMD graphics cards, you can use its graphics processing power for converting videos. Using the graphics card
instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering while converting videos.

AMD hardware acceleration

« Accelerates video processing by up to 2,5x when converting to H.264 video codec for heavy files.

* This option is only available if your computer is equipped with AMD graphics card that supports the Video Coding Engine technology.
* When choosing an output format, look for presets marked with the AMD Video Coding Engine badge.

MOV - Original Size

MOV Same as input  H.264 Auto

Compatible graphics cards
When using the H.264 codec, acceleration will work with graphics cards released after April 2014.

Troubleshooting
How do I find out which GPU my computer has?
1. Right-click on your desktop and choose Display settings
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2. In the Display settings window that appears, click Advanced display settings. This will open your GPU's properties.

The Enable NVIDIA GPU Acceleration option is unavailable
If you can't enable NVIDIA acceleration, try updating your graphics card drivers.
AMD Driver Download Center | Detailed Instructions

Problems while converting video with AMD acceleration

If the video conversion process is taking longer than expected, or there are defects in the output video file:
* Try updating the graphics card driver. Detailed instructions

* Try disabling AMD acceleration on the Acceleration tab of the preferences.

Taking a snapshot

To save a single frame from the video:
1. Click the Play button on the video's thumbnail in the list to view the original file.

3. A Explorer window will open. Choose where you want to save the snapshot and click Save.
The snapshot will be saved with the original video's size and quality.

Movavi Video Converter Settings and Preferences

To open the converter preferences, click the Settings button at the top of the window to open the settings menu. There, click Preferences.
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for Updates

Homepage

The preferences are organized into tabs at the top: General, Conversion, and Acceleration. Click the related tab to find the preferences you
need.

General preferences

Conversion preferences

Acceleration preferences

General preferences

On the General tab of the preferences, you can choose the interface language and control how the application behaves.

Automatically check for updates — select this option and you'll be notified whenever a new version is available. Updates within your version
are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.

Send anonymous usage stats to Movavi — checking this box will allow the program to send usage statistics to our development team,
enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data contains no
personal information, will be used for software improvement purposes only, and will not be disclosed to third parties.

Read our Privacy Policy

Recommend output format for connected devices — when you connect a smartphone or tablet, the program will detect the device and
recommend the optimal format for watching videos on it. Learn more

Use software OpenGL implementation — this option can be useful if your computer doesn't support the necessary OpenGL version and you
see an error message when you start the program.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

If the program works without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting
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Conversion Acceleration

Language: English

v Automatically check for updates

I give consent to send anonymous usage stats to Movavi

Detect low volume in files

Recommend output format for connected devices

Use software OpenGL implementation

ave extended logs for troubleshooting

Show tutorial panel

Conversion preferences

On the Conversion tab of the preferences, you can manage how files are converted.
Under Output file name, you can choose what happens if a file with the same name already exists in the output folder:

- Overwrite existing file: the old file will be permanently replaced with the newly converted file.
+ Automatically rename files: new files will be automatically renamed, and both files will be preserved.

Under After conversion, you can choose what happens when conversion is finished:

* Open output folder: shows the converted files in the output folder.
* Play notification sound: the program will notify you when it has finished converting your files.
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General Conversion Acceleration

Output file name:

Overwrite existing file

&  Automatically rename files

After conversion:

v Open output folder

¥ Play notification sound

Acceleration preferences

On the Acceleration tab of the Preferences, you can accelerate conversion using the latest technologies. You can find out more about each
acceleration method in the Accelerating Conversion section.

General Conversion Acceleration

¥ Enable SuperSpeed conversion )))

Enable Intel® hardware acceleration 'i'ntel

Troubleshooting

If acceleration options are unavailable:

* Your computer might not have the right hardware.

« If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the
manufacturer's website: Intel Download Center | NVIDIA Driver Downloads

Intel HD Graphics is a trademark of Intel Corporation.
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NVENC and CUDA is a trademark of NVIDIA Corporation.
Record computer screen with Screen Recorder

With the screen capture program, you can record any part of your screen with audio and save the resulting video in any format you like.
Firstly, go to the Video tab. Then click Screen Recorder to launch the screen capture program and set up your capture preferences.

If you launch the program for the first time, it will record full screen by default. If you have recorded something before, the program will start
recording the last selected area.
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/
Use Our Video Editing ‘ Upgrade to Movavi How to Add Create Your Own
Services Unlimited Horror Effects Cartoons!

Screen Recorder

Video Editor e Video Converter

Capture from
cameras, VHS, TV

Watch video Gecata

C‘ii Try Realluison R Video Editing
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~ Recent projects and files & Lmep >

Don't know where to start?
Read these tutorials:

Recording screen Recording only audio
Capture any fragment of your Record any sound from a device
screen or the full desktop. or music on your computer.

Scheduling recordings Taking screenshots
Record screen while Take, edit, and share
you're away from your PC. screenshots in a couple clicks.

How to open the capture module

To open the screen capture module:

From launch module
In the Movavi Video Suite launcher, go to the Video tab. Then click Screen Recorder to launch the screen capture program.
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From Video Editor

If you want to add a captured video to your movie, click the Capture Screencast button on the Import tab in the video editing module. The
capture module will open. The recording will be added to your project in Video Editor right after you stop recording.

Fileimport  Project files Sample videos Backgrounds  Intro videos
Import
Add video, audio, and

Drag files or folders here

Add Files ~

()
O] = & =
Record LEEE Record Slideshow
Screencast

Video Audio Wizard

Control panel

The compact control panel is the first thing you see when you launch Movavi Video Suite. The panel provides you with quick access to all
basic tools without blocking the content on your screen.

By default, the panel will be located at the right side of your screen, but you can pin it to any side you like.
Note that the panel cannot block the Windows taskbar (located below by system default).

Right border position (default) Upper border position Left border position

« Click either of the camera buttons to start the area selection tool: to take a screenshot, to record screen.
* Click the cogwheel button H to open Preferences.
» Click E to hide the panel. Click E to show it again.

* Clicking E&3 will minimize the program to notification area. You can access the program from the notification area menu.

Widget management
You can also add one other tool to the control panel for quick access: audio recording or webcam recording.

1. On the control panel, click the plus button M to open the customization window.

2. Click Select below the tool you need on the control panel. Its icon will appear on the control panel instead of the plus.
3. To launch the tool, click its button.

* To change the quick access tool, click the arrow beside its icon and click Select below a different tool.
« To remove a quick access tool, click Remove in the customization window.
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Select a feature for quick access on the control panel.

A\

Webcam recording Audio recording
Record webcam video only. Record only sy
or your mic and get an

.mp3 file.

Remove 4+ Select

Recording video from screen

Launch Screen Recorder
1. Open Movavi Video Suite and go to the Video tab.
2. Then click Launch on the Screen Recorder tile to launch the screen capture module. Here you can set up the capture area.

My programs ° > e o /"_ e

I
{ ; >
Use Our Video Editing ‘ Upgrade to Movavi How to Add Create Your Own i
Services | Unlimited Horror Effects Cartoons!

q e 24 . ﬂ Screen Recorder
Video Editor Video Converter

Capture from Watch video
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c‘{':, Try Realluison s, Video Editing ﬂ AI Upscaling
Cartoon Animator Service

- Recent projects and files

Step 1: Set up the capture area

1. Click the camera button on the control panel or press F10. The area selection tool will start.

2. Select the part of the screen that you want to record:

+ Click and drag on the screen to select the capture area.

* To record a window or a window panel, hover your mouse pointer over it and click once a frame appears around it.
* To record the full screen, press Space or click in any part of your screen (make sure no windows are selected!).

To adjust the area, use the orange markers on the frame to drag it or put the exact size in pixels on the panel above.
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Width 584 Height 350

Adjust
capture area

Step 2: Set up the sound and webcam
By default, only the system sound recording is on. To enable webcam and microphone recording, click the corresponding icons:

E . — Webcam off/on
E . — Microphone audio recording off/on
ﬂ . — System audio recording off/on

If you have more than one microphone connected, select the one you need from a list next to the mic icon.

To remove extraneous sounds, click the cogwheel button © and enable the noise reduction feature. It's handy if you're recording audio in a
noisy place.

A
v

Width 739 Height 448

5

Select _
microphone

@

Microphone setti

i:| MNoise reduction

Step 3: Start recording
When you're ready to begin, click the REC button. You will be given a 3-second countdown before the recording begins.
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Start
recording

Use these keyboard shortcuts to control the recording process:

F9 - pause the recording

F10 - end capture and save the recording

F8 - take a snapshot of the capture area

Tip: these are the default hotkeys. You can change them in the Keyboard Shortcuts section of the Preferences.

Timer : Pause recording  Cancel recording

; 00:00:09 @ ,J?j {é,} 659 @ ” . x
Set your sound up
during recording

_ Snapshot Finish recording

Timer
Set time limit for recording and it will stop automatically once the time is up. This way, you don't have to wait around for the video to end.

1. Click the timer button .

2. Set duration by entering the time limit as hours:minutes:seconds.
3. Choose what happens after capture.

Learn more: Timer

Making notes and drawing shapes on video
Mark important parts during recording — use the Pencil tool to draw or add tidy-looking pointers and other shapes in the middle of your
recordings.

1. Click the pencil button E select the tool, line color and width and draw or add shapes using your mouse cursor. The marks will disappear
5 seconds after you stop drawing and will remain on the finished video.

2. Note that when in pencil mode, all other actions are blocked. Clicking anywhere on the screen will put a dot in the spot. To exit the pencil
mode, click the pencil button again.

00:00:03 {J A
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When you're ready to finish your recording, click Stop on the recording panel or use the F10 keyboard shortcut .

Step 4: Edit the recording (optional)
When you finish recording, the capture editing window will open. Your video is ready and saved in MKV format, but you can preview it, edit, or
export it to a different format.

Cutting the recording

To cut out a fragment:

1. Place the position marker around the unwanted fragment and click the scissors icon.
2. Move the cut markers to adjust the fragment exactly as you want.

3. Click the trash can button.

00:00:05

Share

O L =

Saving the edited recording

To save the trimmed version, or to change the format of your recording:
1. Click the Export button. The output options will open.

2. Choose a name and location for saving the video.

3. Choose a format for saving your video.

4. Click Save to start processing your recording.

File name: . ScreenRecorderProject15
s \Temp\\Videos

Save to:

nal information.

Recording audio only

Besides screen activity, you can just as easily record online music, radio, podcasts, and voice input as standalone audio files.

Step 1: Launch the audio recording tool

1. On the control panel, click the plus button s to open the customization window. Click Select below "Audio Recording" to add it to the
control panel.
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2. Click the microphone button E to start the widget.

Step 2: Set up the audio
On the recording panel, choose which audio sources you want to record from:

Recording system sounds
To record music, online videos, and any other sounds playing on your computer, click the system audio button.

1=

off on

Recording microphone audio
To record sound from a microphone or any other recording device connected to your computer, click the microphone button. If you have
more than one recording device, click the arrow next to the button and select the device you want to record from.

2
off on
Step 3: Record the audio

Click REC when you're ready to begin recording. You will be given a 3-second countdown before the recording begins.

00:00:00

To end the recording, press Alt+F10 or click Stop D on the recording panel.

Step 4: Save audio file

When the recording is finished, the capture editor window will appear. Your audio is ready and saved in MP3 format, but you can play it, cut
out unwanted fragments or export to a different format:

1. Click Export to open the exporting options.
2. Open the list of formats and select a format you need.

3. Click Save to start processing your recording.
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Theaudio

Resolution:

Troubleshooting audio
My device is not available in the list.
If you don't see the device you want to use in the list, it may be disconnected or disabled in system settings.

1. Try re-connecting the device.

2. If that didn't help, right-click the sound icon in the Windows notification area and choose Recording Devices from the pop-up menu. The
Sound settings window will open.

3. Look for your device in the list:

* If the device is working correctly, it should be marked with a green checkmark.

« If you cannot find the device in the list, right-click anywhere in the list and make sure that the options Show Disabled Devices and Show
Disconnected Devices are selected.

« If you still cannot find the device, download a driver for this device from the manufacturer's website and install it. This should help your
system detect the device.

4. Try enabling the device:
« If the device is listed as Not Plugged In, try plugging in the device again.
If the device is listed as Disabled, right-click the device and choose Enable.

Recording webcam only

You can record your webcam footage without recording screen activity.

Step 1: Launch the webcam recording tool

1. On the control panel, click the plus button s to open the customization window. Click Select below "Webcam Recording" to add it to the
control panel.

2. Click the webcam button k= to start the widget.

Step 2: Set up the webcam

1. Right-click the Movavi Screen Recorder icon "“* in the notification area and select Preferences. In Preferences, go to the Webcam tab.
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2. Under Use this webcam, choose the webcam device that you want to use and check that its preview appears on the right.
3. Set up the video options for this webcam:

* Click the Settings button to set up your webcam's options such as brightness, contrast, and exposure. Note: webcam settings are different
for each model.

* Choose the resolution that you would like to use. The higher the resolution, the higher the webcam video quality will be. However, if the
webcam video is small, you may not need a very large resolution.

* For the best quality, use the highest frame rate that your webcam can provide for the best quality. If your webcam is mostly static or if you
want a smaller file size, you may want to use a lower frame rate.

4. Click OK to save the webcam preferences.

Use this webcam:

GENERAL WEBCAM

Resolution:

Settings

Webcam shape:
Rectangle

Circle

Show webcam preview during recording

Scheduler

I OK

Sharing

For screen recordings, where the webcam video is added as an overlay, you can set up the size and position for your webcam:
1. Hover over the webcam overlay and select the preferred size on the panel below.
2. Drag and drop the webcam overlay to the desired corner of the capture area.

You only need to do this once. Enabling webcam recording, both as an overlay and standalone, will automatically use these settings. You can
change them anytime.

Step 3: Set up sound
Next, choose the audio sources that you want to hear on your recording:

System sounds
To record music, online videos, and any other sounds playing on your computer, click the system audio button.
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off on

Microphone

You can record audio from your webcam's built-in microphone, or use an external microphone for better sound quality:
1. Click the Microphone button to enable recording from external devices.

2. Click the arrow above and choose the microphone you want to use from the list.

D
off on
Step 4: Record your video

When you're ready to begin, click REC to start recording. You will be given a 3-second countdown before the recording begins.

/ a8 P, 3 sound
' enabled

Microphone
enabled

Select
microphone

To finish the recording, press Alt+Shift+F10 or click Stop I:I on the recording panel.
Step 5: Edit and export

When you finish recording, the capture editing window will open. Your video is ready and saved in MKV format, but you can preview it, edit, or
export it to a different format.
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To cut or trim the video, use the scissors button on the toolbar. If you've trimmed the file or if you want to save your recording in a different
format, click Export.

Mouse cursor effects

Using mouse effects, you can use the mouse as a pointer and show your viewers where to click. You can enable mouse cursor effects on the
effects panel:

Width: 569 . = Height: 478

By default, the cursor will be highlighted yellow and the mouse clicks red and blue for left and right mouse buttons respectively. However, you
can set up the effects the way you like.

Step 1: Open the mouse cursor options

1. On the control panel, click the cogwheel button H to open Preferences.
2. In the Preferences window, switch to the Effects tab.
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Step 2: Enable the cursor
Select Show cursor on recording. This will make the cursor visible on recordings. To make the cursor invisible, disable this option.

Cursor options:
Show cursor on recording

Highlight cursor:

Highlight clicks:

Mouse click sound:

Step 3: Highlight cursor actions (optional)
To make the cursor visible even better, you can highlight it or enable a special effect for clicks.

Highlight cursor
A semi-transparent circle will appear around the cursor, making it easier to track.

1. Select the Highlight cursor option.
2. (optional) The default highlight is yellow. To change the highlight color, click the square on the right and pick the new color.
3. (optional) Use the Size slider to make the highlight smaller or larger. The cursor itself will remain the standard size.
Hover your mouse over the square on the right to preview the highlight.
Cursor options:

Show cursor on recording

Highlight cursor: E.

Highlight clicks:

Mouse click sound:

Highlight clicks
Concentric circles will appear for every click, color-coded for two mouse buttons.

1. Select the Highlight clicks option.

135



2. (optional) Click the left square to set the color for the left mouse button.

3. (optional) Click the right square to set the color for the right mouse button.

Mouse click sound
A clicking sound will play whenever you click the mouse.

1. Enable the Mouse click sound option.

2. (optional) The default clicking sound has already been selected for you. If you want to use your own sound, open the drop-down box and
choose Add sound. Then, open the sound file that you want to use.
You can use WAV, MP3, AIFF, and AU files.

Recording keystrokes

If you're making a tutorial that uses keyboard shortcuts, it's helpful to display them on screen for your viewers. Enable keystroke recording to
show the keys you pressed at the bottom of the video.

569 L Height: 478

1. On the effects panel, click the keyboard button E

2. To enable keystroke recording, select one of the options:
+ All keystrokes — each key you press will appear on screen, including letters and numbers.
+ Keyboard shortcuts only — only key combinations such as Ctrl+C or Shift+Control+Esc will show up on screen. Letters and keys that do not

cause an action will not be displayed.
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All keystrokes

Keyvboard shortcuts only

To turn off keystroke recording, click the keyboard button again.

Tips:

* Avoid entering any passwords or other sensitive information while you're recording a video with keystroke recording: if you share the video,
your viewers will be able to see each character you type.

* Keyboard shortcut recording does not work with the Windows key.

Scheduling

Any recording can be scheduled for a later time. You can use this to automate your recordings or capture late-night webinars.

Step 1: Set up your recording
Scheduled recordings will start with the currently selected options (system sound, webcam, etc.) Before scheduling the recording:

1. (optional) Default capture area for scheduled recordings is full screen, so if you want to change it, click the camera button on the
control panel and select the part of the screen you want to see on your scheduled recording.

2. To enable system sound recording, click the speaker button ﬂ on the recording panel and make sure it is enabled and highlighted green.

Step 2: Schedule recording

1. On the control panel, click the cogwheel button E to open Preferences. Switch to the Scheduler tab.
2. Select Schedule recording.
3. Click the Add Task button.

General (O Do not schedule recording

#) Schedule recording .

Title Date Time Duration

Audio
Web Camera

Effects

Scheduler .

Sharing | Cancel

4. A task template will appear. Fill in the details for the task:

* Title - the name of your recording

- Date and time - the moment recording should start

- Duration - how long the recording should last (e.g if you want to record an hour long webinar, set this at 01:00:00)

- Capture area - by default, the program will record full screen. However, if you'd like to avoid recording extra parts of the screen, you can
select Current area. Be careful: the program will capture the area selected on screen at the moment your recording starts! If you don't select
the new area, last recorded area will be used.

- After capture - you can set your computer to automatically sleep or shut down when the recording is over.
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Schedule recording
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After capture Do nothing
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Scheduler

Sharing

5. Click Create to add the task to your recording schedule.

Step 3: Enable launching at startup (optional)

The screen recorder needs to be running at the scheduled start time to begin the recording. If you've scheduled the recording for a later date,
enable the program to start with your computer so that you don't miss the recording. To do that, open the General section of the Preferences,
click More and enable the Launch application at startup option.

General . Basic settings
More .
Files .

Launch application at startup

Use software OpenGL implementation

Save extended logs for troubleshooting

Automatically check for updates

sent to send anonymous usage stats to Movavi @

— -
(LN

Audio

ative capture mode (in case of capture @

Scheduler

Sharing

Finally, click OK in the Preferences window to save the changes. After the recording is finished, the recording file will be stored in *. mscproj
format in the output folder with your other screen recordings.

If you are starting a lengthy recording, make sure that you have enough free disk space for saving the temporary recording files.
Time limit
When you record a long webinar or online video, you can limit the recording to a specific time and it will stop automatically once the time is

up. This way, you don't have to wait around for the video to end.

1. Start recording video from the screen.

2. Click the timer button @ and turn on the timer.
3. Set duration by entering the time limit as hours:minutes:seconds.
4. Choose what happens after capture.

5. Click @ again to close the timer preferences. Done!
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Editing recordings
When you end a recording, the player window will open, where you can view the finished video, save videos to a different format, and cut out
unwanted fragments.

Here's what you can do:
Cut recordings — trim videos from the beginning or the end, cut out fragments.

Navigate files — view and edit files from any folder.
Change recording format — save the video in a different video format, as an audio file, or even as an animated GIF.

Share recordings — publish your video online or send it to your friends and colleagues.

Opening the player

To open the capture player and editor, right-click the Movavi Screen Recorder icon % in the notification area and select Preview Saved Files.
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Set Up and Start Recording F10

Audio Recording Alt+F10

Alt+Shift+F10
Ctrl+P

Quit Alt+F4
19:01
06.10.2020 ES

Also, the capture editor will open after you finish recording a video.

Navigating files

The right side of the player is dedicated to your media library. Here are some tips to use it to your advance:

+ The library contains all files you've captured with Movavi Video Suite: videos, audios, and screenshots. To filter the files by type, click & and
select the file type you need to see now.

+ By default, the library shows files from the folder you have set for file recording on the Files tab in Preferences. If you wish, you can view

files from any other folder on your computer. Click E to select a different folder.
Note that Movavi Video Suite can only play files in *. mkv format. Other video files will not be shown in the library.

* To enlarge the player window, you can hide the library by clicking i .

L i i ¥ * 00:05

Cutting recordings

This guide will show you how to cut out parts from video recordings using the built-in capture editor.

Step 1: Cut fragments
1. Move the position marker around the area you want to cut.

2. Click the scissors button. A fragment with two cut markers will appear at the current position.
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Precise positioning

For more precise positioning, click on the cut marker on the seek bar and do any of the following:
* Click the arrows next to the time to move the marker by a small interval.

+ With the cut marker selected, use the arrow keys to move it left or right by 100 milliseconds.

« Manually enter the necessary time.

00:28:021

Step 2: Delete fragments
1. On the seek bar, click a fragment to select it. The selected fragment appears as a darker shade.

2. To delete the selected fragment, click the trash can button above it.

A dotted line will appear on the seek bar where a fragment has been deleted: H

How to undo cutting

To cancel a cutting action, click Undo or press Ctrl+Z. To repeat a cancelled action, click Redo (Ctri+Y).
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To exit the cut mode, click the scissors again.

Step 3: Save the edited video
If you've cut the video, you need to save it to apply the changes.

1. Click Export. The window with saving options will appear.
2. At the top of the window, choose where to save the file and enter a file name.
3. Choose a format for the video. If you don't know which format to choose, leave MP4 selected. It will save faster and at no quality loss.

4. Click Save to start processing the video. This may take a while for longer videos.

ScreenRecorderProjectlS

Format: MP4 (H.264, AAC, Same as input)

Quality

Changing the format

New video recordings are created in the MKV format which is supported by most players. This guide will show you how to save your videos
in a different format. You can also convert your recordings to audio by saving them as an audio format.

Step 1: Open the output options
Click Export to open the output options.

Step 2: Choose a new format
Select a format you want to use:

* Video - MP4, AVI, MOV, MKV

* Image - GIF

* Audio - MP3

Step 3: Save the file
Finally, click Save to convert your recording to the selected format. This may take a while for large videos.
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File name: ScreenRecorderProjectls

E:\Temp\Videos

v MP4 (H.264, AAC, Same as input)

AVI (H.264, MP: me as input)

35 Input)

e as input)

Advanced settings

There are some extra settings you can use to customize your recorded files before saving. To open the settings, click Advanced in the saving
window.

Framing:

Resolution: Original size

FES: Auto
Form I

Sample rate: Auto

] Channels:

Advanced

Resolution

The frame size or resolution determines the videos width and height in pixels. Open the Resolution list to select from the most common
resolutions. Ideally, the frame size should not exceed the resolution of the recorded video, but match it instead. Smaller resolutions allow you
to make the output video smaller and thus save your disk space, however, this will sacrifice some video quality due to downscaling.

Framing

Choosing a resize method can help you manage how your video is resized to fit inside the frame size you've set. There are several resizing
options available:

- Smart fit... — scales the original video to fit the specified dimensions while maintaining the aspect ratio.

- Up to size... — allows you to set a maximum frame size: input files with frame sizes exceeding the maximum are scaled down, while videos
with smaller frame sizes remain unchanged.

» Letter Box — the video will be resized to fit inside the frame entirely. This method allows you to keep the whole video inside the frame
without distortions, but may place black bars around the video.
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« Stretch - the video is fit entirely inside the frame and then stretched on one axis in such a way as to fill the entire frame without leaving
black bars. This allows you to cover the entire frame, however, the objects in the video may appear horizontally or vertically distorted.

« Crop - the video will be resized to be slightly larger than the frame, cropping the parts that do not fit inside it. This allows to cover the entire
area of the frame without distorting any of the objects inside the video or without leaving black bars, however, this may not suit some clips
where important objects are near the edge of the frame.

FPS

The number of frames per second is the number of shots that a camera takes each second to make a video. Most cameras shoot video at
around 24 frames per second. However, some cameras can shoot high-speed video that you can use to make slow motion clips. If you plan
on using high-speed videos, choose the FPS that matches the video. If you're using regular videos, leave the default FPS.

Sample rate

The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default
sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music
tracks.

Channels

Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording
music; mono sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally
preferred number of channels, however, some mobile devices record sound only in mono mode.

Sharing videos

For now, you can share your videos to YouTube, Google Drive, WhatsApp, Telegram, and our own cloud service — Movavi Cloud. You can also
start your mail client to send the file in an e-mail.

To share a recording:

1. In the library, select the recording you want to share.
2. On the bottom panel, select where you want to upload your video, then follow the selected service steps.

144



Learn more about sharing to:
* YouTube

* Google Drive
* Movavi Cloud

Uploading videos to YouTube

Once your video is ready, you can share it to YouTube!
1. Click Sign In and grant all requested access to allow Screen Recorder to upload files.

2. Fill in the details:

* Give your video a title and fill in the description.

- Add some tags to help users find videos by relevant topics. Separate tags with commas.

» Choose a resolution that suits your video. For best results, choose a resolution that is equal to or less than the height of your video (e.g if
your video is 1280x720, choose the 720p resolution).

* Choose a category to help viewers find relevant content.

* Open the Privacy box and choose who you want to see the video.

Tip: if you want to save the video to your disk as well, check the Save to box and select file destination on your computer.

3. Click Start to begin uploading.

* YouTube

Uploading videos to Google Drive

You can use Google Drive to store your videos or share them with others.

1. Click Sign In and grant all requested access to allow Screen Recorder to upload files.

2. After you've signed in, the program will load your Google Drive folder list. You can share files to specific folders if you like. Select one of
them in the list.
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3. Fill in the details: title, privacy settings, the video format and quality.
Tip: if you want to save the image to your disk as well, check the Save to box and select file destination on your computer.

4. Click Start to begin uploading.

A Google Drive

Uploading videos to Movavi Cloud

If you only need to quickly share a file, you can use Movavi Cloud — our own cloud service. It will give you a shareable link in just one click!

1. On the bottom panel, click the Movavi Cloud E icon. The upload will start immediately.

2. Share! The link will be copied to clipboard automatically, but you can also use the copy button or click View in Browser to open the file in
your default browser.

Your file has been successfully uploaded online.

ffsc.com.ly/show/E2UKDugIO? LdfewDsVSTINWZzABMgri

View in Browser

In the browser, you can play the video or download it. The file will be accessible by the link, so if you feel you might need to send it to
someone else some other time, make sure to know where to find it (e.g. in a message you've first attached it to).

Taking screenshots

1. On the control panel, click the screenshot button 6] o press F8.

2. Your cursor will turn into a crosshair. Select the part of the screen that you want to capture:

+ To capture a window or a window frame, hold your mouse pointer over the window and click after a frame appears around it.
* To capture a part of the screen, hold the left mouse button and drag diagonally to draw a rectangle.

* To capture the entire screen, press Space or click on any empty area of your desktop.

* How to take a scrolling screenshot
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Width 798 |, Height 436

Delete
screenshot
Copy to clipboard

4. Now you can edit or save your screenshot.

How to edit your screenshot

Editor
* Click the Editor button to edit your screenshot.

+ Select a tool you want to add to your screenshot: Line ' , Arrow , Frame E or Highlighter . Hold the left mouse button and drag to
draw a shape.

+ Change the color E and width E of your shape.

+ Drag by the green arrow circle o or the white circles on the edges to resize the element; rotate by dragging the green circle left or right: T

Resize

g Save screenshot

+ To add text, select the Text tool, click inside the screenshot frame and start typing in the box that appears. Select a font, change its size
and color as well as the color of text background and outline.

147



. —
«.. s Check this out!
° o, . R T

- un_.g..x. !_‘-' r ""‘
i . : <

ety

°§g |-T:| Save screenshot

How to save your screenshot

* Click the Copy button to copy the image to clipboard without saving the screenshot to a file.

* Click the Share button to share the image to WhatsApp, Telegram, and Google Drive, get a link to the image or send it in an email.
Click Save screenshot button to save the image file and open its containing folder.

Save screenshot

Where are the screenshots stored?
By default, the screenshots are stored in the "\Videos\Movavi Screen Recorder\" folder of your user. You can change where the files are saved
in the Files section of the Preferences.

Scrolling screenshot

1. On the control panel, click the screenshot button E or press F8.

2. Select the part of the screen that you want to scroll and capture: press Space or highlight the needed part of the screen.
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Width 798 Height 436

3. Press Scrolling screenshot in the menu.

Height 436

4. Press Space or left click on the screen and scroll within the selected area.

5. Now you can edit or save your screenshot.

How to edit your screenshot

+ Select a tool you want to add to your screenshot: Line ' , Arrow , Frame E or Highlighter . Hold the left mouse button and drag to
draw a shape.

+ Change the color m and width E of your shape.

+ To add text, select the Text tool, click inside the screenshot frame and start typing in the box that appears. Select a font, change its
size and color as well as the color of text background and outline.

Frames

How to save your screenshot

* Click the Copy button to copy the image to clipboard without saving the screenshot to a file.

* Click the Share button to share the image to WhatsApp, Telegram, and Google Drive, get a link to the image or send it in an email.
Click Save screenshot button to save the image file and open its containing folder.
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Save screenshot

Where are the screenshots stored?
By default, the screenshots are stored in the "\Videos\Movavi Screen Recorder\" folder of your user. You can change where the files are saved
in the Files section of the Preferences.

Sharing screenshots

Note that taking screenshots is only available in activated version.

1. On the screenshot panel, click the Share H button.

2. Select where you want to share your image, then follow the selected service steps. It's that easy!

Width: 647 o

The world of computer games is packed with challenges,

triumphs, and failures. With a gaming video recorder, you can
share all your experiences with your peers across the planet.
Grab in-game video from any major title with your PC using
Gecata — Movavi's lightweight game recorder. Create a
collection of the most memorable mo of your gaming life.
You can even start a YouTube channeaenain others with

your game reviews, Let's Plays, humorous sketches and

walkthroughs.

Sharing screenshots to Google Drive
Uploading images to Google Drive will take you a couple extra moves.

1. Click Sign In and grant all requested access to allow Screen Recorder to upload files.

2. After you've signed in, the program will load your Google Drive folder list. You can share files to specific folders if you like. Select one of
them in the list.

3. Fill in the details: title, privacy settings, and the image format.
Tip: if you want to save the image to your disk as well, check the Save to box and select file destination on your computer.

4. Click Start to begin uploading your image.
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A\ Google Drive

Learn more: How uploading files to Movavi Cloud works

Screen Recorder preferences

To open the program settings for Movavi Screen Recorder, click the cogwheel button H on the control panel:

The preferences window will open. The preferences are organized into eight categories: General, Files, Keyboard Shortcuts, Video, Webcam,
Effects, Scheduler and Sharing.

General preferences

The General tab allows you to change the basic behavior of the program. The settings are organized into two groups for your convenience.

Basic settings

General Basic settings
Interface language:

English

Disable countdown

Hide recording panel

Disable frame blinking during capture
[v] Allow window panes selection

Capture separate streams

Webcam

Enable sound notifications

More

Scheduler

Sharing

Disable countdown
Every time before the recording starts, you will see a 3-second countdown. This gives you time to prepare for your recording. Select this
option to turn the countdown off and start recording immediately.

B Hide recording panel

151



The recording panel appears when you start recording. It's semi transparent and it will not be recorded on top of your finished video even if
you record fullscreen, but you can hide it if necessary.

00:00:12 B Il X

B pisable frame blinking during capture
In case the blinking irritates you, check this box. The frame will stay still during recording.

Allow window panes selection
To record only the main window panes (no frames, menus or browser tabs), Movavi Screen Recorder needs access to your screen.

= Capture separate streams
When recording a video, the webcam, main onscreen video, external audio, etc. will be recorded as separate streams, like layers.
This can be useful for editing the video later, so you can edit them separately.

B Enable sound notifications
The program will notify you when a screenshot has been taken, a file export is finished, or if an error occurs.

Other settings

Launch application at startup
Use software OpenGL implementation

Save extended logs for troubleshooting

Automatically check for updates

Webcam -
yebat Aero theme during capture

Use DirectX for capturing

Scheduler

Sharing

B Launch application at startup

With this option enabled, Movavi Screen Recorder will start when you log in and run in the background. This way you will always be ready to
capture your screen.

B use software OpenGL implementation (advanced)
This option can troubleshoot OpenGL problems for some graphics cards.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

Save extended logs for troubleshooting

In case you experience trouble using the program and contact our support team, they might ask you to collect logs. The logs contain the
program's actions for some period of time, as well as important error reports and descriptions. Extended logs give the most amount of
information which may be essential to solving your problem.

= Automatically check for updates
The program will notify you if a new version is available. Minor updates are absolutely free (for example, from v.1.3 to v.1.4). For major
updates users with purchased Movavi Video Suite license will get a considerable discount.

| give consent to send anonymous usage stats to Movavi

Enabling this box will allow Movavi Video Suite to send us anonymous data about how you use the program. This data does not contain any
personally identifiable information and is only used for improving our software. You can find more information on our Movavi Privacy Policy
page.

B pisable Aero theme during capture
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Windows Aero themes that use transparency require more processing power. This may slow down your computer while recording video.
With this option enabled, the program will disable the Aero theme while recording to improve performance. The theme will be restored after
recording has finished.

(For Windows 7)

B use DirectX for capturing

Try this option if you are experiencing problems capturing some program windows. In Windows 8 and above, the capture method is chosen
automatically and this option is unavailable.

(For Windows 7)

B use alternative capture mode
If you get an error message when you start or stop recording your screen, try this option.
(For Windows 8 and above)

File preferences

In the Files section of the preferences, you can change where your captured files are stored. To change a folder location, click Browse and
select a new folder.

Record files to:

E:\Temp'Videos), Browse

|:| Delete original recording after export

Keyboard Default screenshot format:
Shortcuts

PNG W

Webcam

Scheduler

Sharing

Record files to...
This is where all your captured files are saved automatically, both screenshots and video recordings. If you export the file, you can select a
different folder.

B pelete original recording after export
If you save the recording in a different format or trim the file, the original will be deleted.

Default screenshot format
Here you can change the format for all new screenshots. You can also change the format for a single screenshot by using the Save As button
in the editor window to save a copy with a different format.

Keyboard shortcuts

The Keyboard Shortcuts tab allows you to set your own custom shortcuts for such actions as starting or pausing the capturing process. On
the right, you can see keyboard shortcuts for every action.
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Click in the K e key combination that
yvou want to n to the menu command.

F10

Keyboard i _
Shortcuts AlE+F10

Alt+Shift+F10

Webcam

'f: Reset to Default :f'

Scheduler -
cHedHiEr [ ] Disable keyboard shortcuts

E: I-I 3 r-l n g \_ Cance |

To change one of the shortcuts:

1. Click inside the box with the shortcut you want to change. The box will become blank.

2. Simultaneously press on keyboard the keys you want to use as a shortcut to the selected action. The box will now display your custom
shortcut.

3. Click OK to apply the changes. To reset all the keyboard shortcuts to their original state, click the Reset to Default button.

If there's a keyboard shortcut you want to use in other software while Movavi Screen Recorder is running, check the E pisable keyboard
shortcuts box.

In case you forget a shortcut, you can always look it up here in the keyboard shortcut settings.

Video preferences

On the Video tab, you can choose how the videos are recorded and saved, change the preferred audio quality, including the sample rate,
number of channels, and bits per second.

Audio quality:

44.1 kHz, stereo, 16-bit
kKevboart
Shortcuts - _ .
|v| Enable SuperSpeed conversion Super
Speed

Intel® HD

Graphics

R NVIDIA
Webcam S e NVENC

AMD

VCE

Scheduler

Sharing

Frame rate

The frame rate defines how many frames will be captured each second and affects the smoothness of motion in the video. A lower frame
rate will result in smaller output size, however, the video may not turn out as smooth. The recommended frame rate is 20-30 frames per
second.

Sample rate
The first number is the audio sample rate, measured in Kilohertz (kHz). This is the number of digital samples taken each second to record
sound. Higher sample rate usually means higher quality. 44.1 kHz is the recommended sample rate, which corresponds to the human
hearing range.
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Channels
Mono uses only one audio channel, which saves some disk space.
Stereo uses two audio channels, which allows distinguishing the direction a sound is coming from and usually sounds more natural.

Bit depth
Screen Recorder will record audio at 16 bits, which is the standard bit depth for most audio recordings. This means that every sample
contains 16 bits of information to encode sound.

B Enable SuperSpeed conversion
This option will make saving videos faster if you use the same output video codec. For example, if you cut the video without changing the
format. If you're having problems with saving some files, try disabling this option.

Enable Intel hardware acceleration
This option will make saving videos faster if your computer is equipped with a compatible Intel® graphics chip. Intel acceleration works
when processing H.264, MP4, and MPEG-2 videos.

B Enable NVIDIA GPU acceleration

This option can make saving videos faster by using the graphics card to process media files. This leaves the CPU free for other tasks and
improves performance while saving videos. This option is only available if you have an NVIDIA® graphics card compatible with the NVENC®
or CUDA® technologies.

B Enable AMD acceleration
This option is meant for the same purpose as the ones above: it allows to save videos faster, too, but this time you need an AMD graphics
card to use the acceleration.

Webcam preferences

The Webcam section of the preferences allows you to set up your webcam for recording it on top of the main video.

Use this webcam:
GEMERAL WEBCAM
Resolution:
720 x 480

Frame rate:

Settings

Webcam shape:
Rectangle

Circle

Show webcam preview during recording

Scheduler

Sharing

Enabling the webcam
1. Connect the camera to your computer and wait until your system installs the necessary drivers.
2. In the Webcam preferences section, select the camera you want to use from the 'Use this webcam' box.

If the camera does not appear in the list, try manually installing the driver that came with your camera. You can use the preview square on the
right to check that the camera is working properly.

Webcam properties
Clicking the Settings button will open the camera's properties. These properties are different for each manufacturer, but generally you can
use them to calibrate the brightness, contrast, and exposure of your camera.

Resolution
The resolution affects the quality of the output video. If the video is very small, you can choose a lower resolution without a noticeable
decrease in quality.

Frame rate

Frame rate is the number of shots the camera takes each second. Higher frame rates will make the movements look smoother and work
best for videos with a lot of motion. If the picture is mostly static, you can decrease frame rate to save disk space. The standard frame rate is
20-30 frames per second.

Webcam shape
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Select the shape of the webcam overlay.

B show webcam preview during recording
When recording screen with webcam, you will see your webcam overlay preview in the lower right corner (unless you've set a different
webcam position on video).

Size and position on video

You can resize and relocate your webcam right on the capture area:
1. Hover over the webcam overlay and select the preferred size on the panel below.
2. Drag and drop the webcam overlay to the desired corner of the capture area.

Effects

In the Effects section of the preferences, you can set up the visibility of your mouse and keystrokes.

Cursor options:
Show cursor on recording
Highlight cursor:
e ———
L] ik

Highlight clicks: v ]

Mouse click sound:

<eystroke recording options:
() Do not capture keystrokes

() Keyboard shortcuts only

() All keystrokes

Scheduler

Sharing

Cursor options
Select I Show cursor on recording to make the cursor visible to your viewers.

Highlight cursor

This option will add a bright circle around the mouse cursor to make it more visible.

1. Select the Highlight cursor option.

2. Click the square on the right to choose the highlight color. Use the Alpha channel box to change its opacity.
3. Use the size slider to change the size of the highlight circle.

Hint: hover your mouse over the preview square on the right to see how it will look on the recording.

B Highlight clicks
This option will flash a circle around the cursor for every click. You can set two different colors for the left and right mouse buttons.
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1. Enable the Highlight clicks option.
2. Click the left square to set the color for the left mouse button.
3. Click the right square to set the color for the right mouse button.

B Mouse click sound

A clicking sound will be played every time you click the mouse to draw attention to your actions.

1. Enable the Mouse click sound option. The default mouse click sound will be used.

2. (optional) If you have a file with a different sound effect you want to use, open the box under ' Mouse click sound ' and choose Add sound.
Then, open the audio file with the sound effect. You can use WAV, MP3, AIFF, and AU files.

Keystroke recording options

« Keyboard shortcuts only — only functional keys and key combinations (for example, Alt+Shift, or Ctrl+C) will appear on the video.
« All keystrokes — all key presses, including letters of the alphabet, will appear on the video.

Hint: avoid entering passwords when this option is enabled if you don't want everyone to see your password.

Scheduler

In the Scheduler section of the preferences, you can start and stop recordings automatically.

General (0 Do not schedule recording

Schedule recording

Lesson 1

Hotkeys N
Date: 09/16/2022

\ Time: Duration: 00:00:05 &
Capture area: Y Cu s

Audio
After capture

Web Camera

Back

Scheduler

Sharing Cancel

Automatically ending a recording

1. Select the "Set time limit for recording” option.

2. Enter the duration of the recording as hours: minutes: seconds.
Learn more: Time limit

Scheduling a recording

To start and end a recording automatically:

1. Select the "Schedule recording" option:

2. Click "Add Task" button.

3. Fill in the details and click Create to add your task to the recording schedule.
Learn more: Scheduling

The Screen Recorder application must be running at this time for the recording to begin. To make sure you don't miss it, enable the "Launch
application at startup” option in the General section.

Sharing preferences

The Sharing tab allows you to manage your YouTube and Google Drive accounts used to upload videos to.
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Sign In...

A Y Sign In...

Webcam

Scheduler

Sharing

To sign in to your account:
1. Click Sign In. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Screen Recorder upload videos.

Capture video

Follow the steps below to record video from a camera that's connected to your computer.

Connect the camera

Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is working
correctly.

Launch the video recording program
1. Open the Movavi Video Suite launcher window and go to the Video tab. Then click Launch on the Capture from cameras, VHS, TV tile.

a Record computar screan
s Capture from cameras,
L]

VHS, TV ’ Launch o

~ Recent projects and files

—

el

2. In the Video capture device box, choose the camera.

3. Then, select the resolution and frame rate. A larger resolution will be able to retain better quality, however, the video file size will be larger.
A higher frame rate is necessary for recording motion, while static scenes can be captured with a lower frame rate.

4. In the Audio capture device box, choose the microphone.
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Logitech HD Webcam C270

Resolution: Frame rate:

Default v 30

Audio capture device:

MukpodoH (HD Webcam C270)

5. Choose a destination folder. By default, the recordings will be saved to your Movavi Library folder. To change it, click the icon o near the

Save files to box.
6. Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera icon on the right.

Capture settings

* Saving captured files

Import AVCHD

Follow the steps below to import previously recorded videos from an AVCHD camera.

Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera. Make sure that
the system recognizes the device and that it is working correctly.

Step 2: Open the Movavi Video Suite launcher window and go to the Data tab. Then click Launch on the Import AVCHD tile.
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Services 4 Unlimited <& | / Horror Effects Cartoons!
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: Import AVCHD l Burn disc a Burn image to disc

Copy disc to disc Copy disc to hard " Mobile Companion
drive

Step 3: In the Video capture device box, select your AVCHD camera.

Caplure seblings
¥ H - P -
Video capture device:

Sony Camcorder

Saving caplured files

Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere else, click the

folder button under 'Save files to' and choose a different location.

Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file
name template.

Step 7: Click Export files to start copying the files. This may take a while depending on the size of the videos.
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Caplure sellings

Saving caplured files

Export Files

Capture audio

Connect a microphone
Connect a microphone to your computer and make sure that it is recognized by the system.

Launch the audio recording module

Open the Movavi Video Suite launcher and go to the Audio tab.

Then click Launch on the Record sound tile. The audio recording module will open in a separate window.
If you want to start recording right away, click Start Recording on the Record sound tile.

« .
\ N
How to Add Use Our Video Editing ' High-Quality Stock ‘ Recreate Zack King's

Horror Effects Services : Videos! k Tricks

Audio

a Video Converter 24 ** Record sound Burn audio to CD

Set up audio capture

In the Audio capture device box, choose the microphone or whichever device you want to use for recording sound. To record audio that is
playing on your computer*, choose Stereo Mix or Speakers.

In the Saving captured files section, you can choose a template for naming the captured files. To do that, open the File renaming box and
choose date or free text. Then, fill in the template details and the recordings will all be named after this template.

Under Save files to, specify the folder where you want to save the recordings. Click the folder icon next to the box to browse for the folder
you need.
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Capture settings

Audio capture device:

MukpodoH (Realtek(R) Audio)

Saving captured files

files to:
rs\s.kotina\Videos\Movavi Library

File renaming:

Keep original name

Record

Click Start Capture to begin recording. As you record sound, you can see the frequencies reflected as color bars in the center. When you're
done, click Stop Capture. If you need to record more audio clips, simply repeat this step.

The audio files will be saved to the folder specified in the Save files to box. To open this folder, click the View saved files button.

Capture settings

Audio capture device:
MukpodoH (Realtek(R) Audio)

Saving captured files

Save files to:

\Users\s.kotina\Videos\Movavi Library

File renaming:

Keep original name

View saved files

*Depending on the model of your audio card, this option may be named differently. Some device manufacturers do not include a system audio
recording option.

Play video and audio

With the Movavi Video Suite player, you can play video and audio in any format without having to install any additional codecs or software.
To open the player, go to the Video tab. Then click Launch on the Watch video tile.
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Or go to the Audio tab and click Launch on the Play music tile.
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Play music

Opening files

To open video or audio files, click the buttons in the bottom right, under the playlist.

+ File to open individual files
+ Folder to open all the files in a folder

+ DVD to select a disc with videos. You will need to find the VIDEO_TS folder on the disc.

Or you can simply drag any files you want to play right onto the player window.

00:00 i

Basic playback buttons

M W M

L

Movavi

Media Player

WWW.movavi.com

+ File

| T N e R

Playback
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Movavi

Media Player

www.movavi.com

Play / Pause Fullscreen mode

+ Fie + Foider + VD

Previous file | Next file |

Skipping frames
On the toolbar, click Skip forward m or Skip backward buttons to skip 10 seconds forward or backward.

Playlist buttons

The playlist displays your media queue. If you want to jump to another item, double-click it in the playlist to play.
To show or hide the playlist, click the List button E on the toolbar.
To play all items in random order, click the Shuffle button .

. . o 'S
To play the same item again and again, click the Repeat button .

Adjust video

In Movavi Video Suite, you can adjust brightness, contrast, hue and saturation of the video.

Step 1: Open Video Adjustments dialog box
Click the Adjust video button on the toolbar.

The Adjust video button
Step 2: Adjust video
Hold your mouse on the markers and drag them left or right, depending on the changes you want to make. Release the markers to see how
your video has changed.

Brightness
Contrast
Hue

Saturation a

| omeset N apy N cancel
el e .
4" i

.
N
!

If you are satisfied with the results, click Apply to save your settings.

Change audio track

In Movavi Video Suite, when you watch a video with two or more audio tracks, you can easily switch between them.

In the menu, click Audio and select Audio Track in the pop-up menu. A list of available audio tracks will appear. Select the one you need. You
will hear it immediately.

164



File Playback Video Subtitles View Settings Help

Audio Track r 1) rus (AC3)

Volume Up  Ctrl+Up 2) ukr (AC3)
Volume Down Cirl+Down | ¥ 3) eng (DT3)

Subtitles
Changing subtitles track

In the menu, click Subtitles and select Subtitle Track in the pop-up menu. A list of available subtitle tracks will appear. Select the one you

need. You will see it on screen immediately.
View Settings Help

Subtitle Track r Mo Subtitles

File Playback Video Audio

Synchronize Subtitles » Track 1 - rus

Align Subtitles 4 Track 2 -rus
Track3 - rum

v Track4 -eng
Add Subtitle File...

To load subtitles from a file, select Add Subtitle File on the list.
Subtitle timing

You can adjust your subtitle timing in case you notice it's off track. In the menu, click Subtitles and select Synchronize Subtitles in the pop-
up menu. A list of options will appear. Select the one you need. (For example, clicking +5 seconds will make subtitles appear on screen 5

seconds later than before).
File Playback Video Audio
Subtitle Track J

Synchronize Subtitles *| v Default

Align Subtitles * +5 seconds  Ctrl+Pglp
-5 seconds  Ctrl+PgDown
+0.5 seconds Ctrl+W

-0.5 seconds Ctrl+Z

Subtitles positioning
To move subtitles, click Subtitles in the menu and select Align Subtitles in the pop-up menu. A list of positioning options will appear. To set
subtitles to a certain part of the screen, choose Top ... Right. Clicking Move up ... Move right will slightly move subtitles around the screen.

File Playback Video Audio

Subtitle Track *
Synchronize Subtitles »

Align Subtitles

* |« Default
Top
Center Vertically

Bottom

Left

Center Horizontally

Right

hMove up Alt+Up
hove down Alt+Down
Move left Alt+Left
Move right Alt+Right

Movavi Account

How to log in or register

To log in or register to your Movavi account, click on the icon in the top-right corner of the launcher and select My Account.
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Choose how you want to login or register:
+ with Google
« with a special link (we'll send you an email with a link to log in instantly and without a password)

Log in to your Movavi Account
New here? Cre
o =
9,® Movavi Account

Log in to activate your programs and manage
your subscriptions

Movavi Account
Your account page has the following categories:

* Personal Info: view your account info and change password.

* Programs: view all the Movavi programs that you purchased.

« Effects: here you can find your effect packages from Movavi Effects Store and install the new ones. More about installing packages
* Subscriptions: view and renew your subscriptions to Movavi programs.

* FAQ: go to our FAQ page.

* Support: go to our support center.

Note: when you purchase an item, it gets linked with the email you provide at checkout. In you account, you only see what you bought with
the email you logged in with.

Personal Info

Please note: all purchased programs and effects are linked to the email you provided during the purchase. If you made a purchase using a
different email and do not see new products in your personal account, you can link additional email. To add a new email, go to the Personal
Info section and click Add Email. An email with a confirmation link will be sent to the specified address.
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My Account

Personal Info Programs ffects rip FAQZE  Support Center &

Help and support

If you have any questions, visit the Movavi Support Center. You can also contact our support team via the chat or the contact form on the
website.

Frequently asked questions:

How to remove trial restrictions?

Why do my videos have "trial version" on them

What are the system requirements for running Movavi Video Suite?
How to update the graphics card drivers?

System requirements

Minimum system requirements Recommended configuration

Operating system Windows® 7/8/10 with latest service packs and patches

Processor Intel®, AMD®, or compatible dual-core 2.8 GHz quad-core or higher multi-core 64 bit
processor, 1.5 GHz processor

Graphics card Intel® HD Graphics 2000, NVIDIA® NVIDIA® NVENC hardware acceleration

GeForce® series 8 and 8M, Quadro FX requires an NVENC-enabled graphics card with
4800, Quadro FX 5600, AMD Radeon™ at least 512 MB VRAM and an up-to-date driver
R600, Mobility Radeon™ HD 4330, Mobility

FirePro™ series, Radeon™ R5 M230 or

higher graphics card with up-to-date

drivers
Resolution 1280x768, 32-bit color 1920 x 1080 or higher
RAM 2GB 8 GB
Available disk space 830 MB for installation 5 GB for ongoing operations
2 GB for ongoing operations* HD video processing may require larger

amounts of free disk space
Administrator permissions are required for installation
VHS capture requires a VHS player, and a VHS capture device
Additional features: Sound card for audio recording and playback

Intel® hardware acceleration requires a
compatible Intel processor supporting Intel HD
Graphics™ 2nd generation or higher
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Learn more

For intended performance, make sure that your
graphics card drivers are up-to-date.
Updating graphics card drivers

* Free disk space is required to save the temporary recording file and the output video. The required amount of disk space will depend on the
resolution, format, and length of your videos.

Movavi Video Suite may also run on slower machines, however, we cannot guarantee stable performance if the minimum requirements are
not met.

Supported formats

3GPP (.3gp), 3GPP2 (.3g2) H.263, H.264, MPEG-4

ASF (.asf) MPEG-4, VC-1, WMV V7
AVI (.avi) v H.264, MPEG-4, MJPEG
DivX, Xvid, DV, Cinepack, Fraps, TechSmith, Uncompressed
DivX Video (.divx) DivX
DVD v

Flash (.flv, .swf) v FLV1, H.264

VP6, H.263, Flash Screen Video

v MJPEG

v H.264, MPEG-4, MJPEG, Theora, VP9
DV, Uncompressed

v MPEG-2, H.264

MPEG-2, H.264

v MPEG-1, MPEG-2

MPEG-1, MPEG-2, H.264

v MPEG-4, H.264

H.263, MJPEG, ProRes

Matroska (.mkv)

MPEG Transport Stream (.m2ts)

MPEG Transport Stream (.ts, .mts, .m2t)

MPEG (.mpg, .vob)

MPEG (.mpeg, .mpe, .m1v, .dat, .mod, .tod, .vro)
MPEG-4 (.mp4)

MPEG-4 (.m4v) MPEG-4, H.264, H.263, MJPEG, ProRes
MXF — Material eXchange Format (.mxf) MPEG-2, DV
OGV - Ogg Video (.ogv) v Theora

MPEG-4

v H.264, MPEG-4, MJPEG

AIC, ProRes, Sorenson 1/3, PNG

H.264, MPEG-4, AIC, MJPEG, ProRes, Sorenson 1/3
Real Video 2/3/4, Cooker

v VP8, VP9

VP7

WMV V8

WMV V7, WMV 9, WMV 9 Screen, WMV 9 Advanced profile, MPEG-4,
WMV 9.1 Image V2

QuickTime (.mov)
QuickTime (.qt)
RM (.rm, .rmvb)
WebM (.webm)

WMV - Windows Media Video (.wmv)

((((((((((((((E( CLCLC LSS €] € LK€K K
<

WTV (wiv) H.264, MPEG-2
oupd  Swportcatees
AAC - Advanced Audio Coding (.aac) v AAC
AIFF (.aif,.aiff) AIFF
APE - Monkey's Audio (.ape) Monkey's Audio
Au (.au, .snd) WAV
FLAC - Free Lossless Audio Codec (.flac) v FLAC
MP3 - MPEG-1/2 Audio Layer Ill (.mp3) v MP3
MPEG-4 (.m4a) v AAC, ALAC
MPEG-4 (.m4b) AAC, PCM
Opus (.opus) Opus
OGG - Ogg Audio (.ogg) v Vorbis
WAV - Waveform Audio File Format (.wav) v PCM
AAC, MP3
WMA - Windows Media Audio (.wma) v WMA 9
WMA Pro, WMA Voice
I

APNG (.apng)
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BMP (.bmp) v
DPX (.dpx)

GIF (.gif) v
JPEG (.jpg) v

JPEG (.jpeg, .jpg, .jp2, .jls)
Netpbm formats (.pgm, .pbm, .ppm, .pam)
PCX (.pcx)

PNG (.png)

PTX (.ptx)

SGlI (.sgi)

TARGA (.tga)

TIFF (.tiff)

WebP (.webp)

XBM (.xbm)

XWD (.xwd)

SR SR SRR SRR SE SR SR G SR SR SR SR ¢
<

How to collect logs

Providing your log files when you contact support can help us solve your problem faster. The logs contain the program's actions for some
period of time, as well as important error reports and descriptions. The log files do not contain any personal information.

Note that extended logs give the most amount of information which may be essential to solving your problem. To save extended log files, go
to Preferences in the top-right corner of the screen and check 'Save extended logs for troubleshooting'.

Once you’ve done that, repeat the same actions in the program that previously caused errors.

* Wildso Suits IT

| Get All Mz
Bifeces at Or

After that, you need to collect logs and send them to us:

1. Download a utility which will collect logs.

2. Launch it and wait until the log collecting process ends.

3. Once the process is complete, the folder with the movavi_logs.7z archive will open.
4. Send this archive to Movavi Support Center.

Updating graphics card drivers

If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics
card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a
driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance
of applications and games on your computer.

Step 1: Find your graphics card manufacturer
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1. Right-click your desktop and choose Screen Resolution

2. In the Screen Resolution settings window, click Advanced settings.

3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type
section. Note the full name of the graphics card somewhere for later.

Step 2: Download the new version

Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There,
look for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility
that will automatically find the necessary driver.

NVIDIA download center

AMD download center

Warning:
Only download drivers from the official manufacturer's website. Third-
party websites offering driver downloads may contain malware.

Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on your system. Your
display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.

Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows
you to optimize your computer's graphics performance.

1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please
try the method above.

2. In the Drivers section, click the Check for updates button to find the latest drivers.

3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and
install the necessary driver for your system.

— % —
A new driver is available for your GPL Check for updatﬁ

Difrver update
Download driver

Updating AMD® or ATI® Driver

1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center

2. Download the auto detect utility and run it when the download has finished.
Download Auto Detect Utility

3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads
page and download the driver.

4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
5. After the driver has been installed, it is recommended that you restart your computer.

If none of the above steps have helped, visit the Movavi Support Center or contact our support team via the chat or the contact form on the
website.

If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have
encountered. This will help our support team specialists solve your problem quicker.

OpenGL troubleshooting
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If you see the following message about OpenGL when you open Movavi Video Suite, your computer most likely does not support the
necessary version of OpenGL. To run Movavi Video Suite, your computer needs to support at least OpenGL version 2.0, and version 2.1 is
required for smooth performance.

¥Your graphics card driver does not support the necessary OpenGL version.
The program may fail to start or work incorrectly.

Chick the link below to download and install the latest graphics card driver or see the full
troubleshooting guide.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:

Step 1: Update your graphics card driver

Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver
installation file from the manufacturer's website and install it following the on-screen instructions.

Detailed instructions on updating the driver

It is recommended that you restart the computer after installing driver software. After that, try starting Movavi Video Suite. If you see an error
message again, proceed to the next step.

Step 2: Try the software OpenGL implementation
If your graphics card still doesn't support OpenGL 2.1 even after updating the driver, you can use a software alternative:

In the message you see after starting Movavi Video Suite, select the Download and install software OpenGL implementation box.

Or, in the main Movavi Video Suite window, open the Settings menu and choose Preferences. There, select the Use software OpenGL
implementation option and click OK.

¥ our graphics card driver does not s
The program may fail to start or wo

Cancel

After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi
Video Suite.

If these steps haven't helped:
* Check that your computer meets the minimum system requirements. Your graphics card must support at least OpenGL 2.0.
+ Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem.

Hardware acceleration

Movavi Video Suite is optimized for the latest Intel®, NVIDIA®, and AMD hardware acceleration technologies.

Intel acceleration

Movavi Video Suite supports hardware acceleration provided by Intel® multi-core processors and integrated graphics, which allows for faster
encoding/decoding, as well as simultaneous conversion of a large number of files by employing the full power of each core. Performance
grows up to 400% for H.264 and MPEG-2 codecs and up to 8 files can be processed simultaneously.

Supported Formats

Input Video Formats: AVI, MP4, FLV, MKV, MOV, MPEG2-TS with H.264 codec; MPEG (MPEG2 PS, MPEG2 TS) with MPEG1/MPEG2 codec;
WMV with VC-1 codec.

Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec; M2TS, MPEG with MPEG2 codec.

NVIDIA acceleration

If your computer is equipped with an NVIDIA® graphics card, you can use it to accelerate media file processing up to 5x by shifting a part of
the workload to the graphics processing unit, freeing up your computer's CPU for other tasks. This technology supports the newest NVIDIA®
graphics cards, including GeForce™, GeForce Mobile, Quadro, and Quadro Mobile.

CUDA™ technology allows you to speed up video conversion to AVI, MP4, FLV, MKV, MOV and MPEG-2 TS formats with the H.264 codec.

AMD acceleration

If your computer is equipped with an AMD graphics card, you can use it to accelerate media file processing up to 2,5x, especially for heavy
files (2K & 4K).
Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec. MP4, MOV, MKV, M2TS with H.265 codec.

Enabling hardware acceleration
To enable Intel or NVIDIA acceleration in Screen Capture, or Video Converter:
1. Open the Settings menu and select Preferences.
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2. In the Preferences window, select the acceleration method that is compatible with your computer.
3. Click OK to accept the changes.

To enable Intel or NVIDIA acceleration in the Video Editor:

1. Open the Edit menu and select Preferences.

2. In the Preferences window, switch to the Acceleration tab.

3. Select the acceleration method that you prefer. For Intel® acceleration, you can choose hardware or software acceleration methods for
each of the supported codecs.

4. Click OK to accept the changes.

Troubleshooting

If the acceleration option is unavailable it may mean one of the following:
* Your computer is not equipped with the right hardware

* The driver may be out of date or not installed.

Intel Download Center

Updating graphics card drivers

172


https://downloadcenter.intel.com/

	Movavi Video Suite
	Table of Contents
	Activating Video Suite
	Activating without Internet access
	Getting an activation key
	Trial limitations

	Launcher
	My files
	Uploading files online

	Edit video with Video Editor
	Activating and installing packages
	Quick Video mode
	New Project mode – quick start
	Creating and managing projects
	Appending a project

	Adding media files
	Creating an intro
	Recoding video

	Preview and organize clips
	Gaps on the Timeline

	Edit and enhance clips
	Rotating videos and images
	Cutting clips
	Cropping video
	Color adjustments
	Video speed
	Reversing video
	Image duration
	Fading video
	Creating overlays
	Adding a watermark
	Creating a freeze frame
	Removing black bars
	Fading effects

	Adding and editing audio
	Recording audio
	Extracting audio from videos
	Looping audio
	Volume curves
	Linking audio
	Fading audio
	Equalizer
	Noise removal
	Audio effects
	Beat detection
	Synchronization

	Filters
	Transitions
	Titles
	Timer
	Saving a preset

	Stickers
	Animation
	Pan and zoom
	Stabilizing video
	Highlight and conceal
	Chroma key
	Exporting videos
	Export only audio
	Export for devices
	Export for TVs
	Uploading online

	Editor preferences
	General preferences
	File preferences
	Sharing preferences
	Acceleration preferences


	Convert files with Video Converter
	Launch the converter
	Converting media files
	Opening media
	Choosing output format
	Compressing files
	Converting DVDs
	Creating GIFs from videos
	Merging files

	Customizing presets
	Image formats
	Audio formats
	Devices

	Media streams
	Audio tracks
	Subtitle tracks
	Online subtitle search
	Extracting subtitles


	Editing media files
	Trimming files
	Rotating video
	Cropping video
	Adding a watermark
	Editing subtitles
	Adding effects
	Adjusting colors
	Adjusting audio
	Low volume detection


	Uploading files to iTunes
	Accelerating conversion
	SuperSpeed conversion
	Intel® Hardware acceleration
	NVIDIA® Hardware acceleration
	AMD Hardware acceleration

	Taking a snapshot
	Preferences
	General preferences
	Conversion preferences
	Acceleration preferences


	Record computer screen with Screen Recorder
	How to open the capture module
	Control panel
	Recording video from screen
	Recording audio only
	Recording webcam only
	Mouse cursor effects
	Recording keystrokes
	Scheduling
	Time limit
	Editing recordings
	Opening the player
	Navigating files
	Cutting recordings
	Changing the format
	Advanced settings

	Sharing videos
	Uploading videos to YouTube
	Uploading videos to Google Drive
	Uploading videos to Movavi Cloud

	Taking screenshots
	Scrolling screenshot

	Sharing screenshots
	Screen Recorder preferences
	General preferences
	File preferences
	Keyboard shortcuts
	Video preferences
	Webcam preferences
	Effects
	Scheduler
	Sharing preferences


	Capture video
	Import AVCHD

	Capture audio
	Play video and audio
	Opening files
	Playback
	Adjust video
	Change audio track
	Subtitles

	Movavi Account
	Help and support
	System requirements
	Supported formats
	How to collect logs
	Updating graphics card drivers
	OpenGL troubleshooting
	Hardware acceleration


